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RESUMEN 

 

El presente trabajo de investigación se desarrolló en la cuenca del río Huarmey, que abarca 

parte de las provincias Huarmey, Aija y Recuay pertenecientes al departamento de Áncash. 

Esta cuenca tiene una región costera, donde las lluvias son escasas, y una región andina 

donde se presentan fuertes precipitaciones anuales, siendo esta la zona más vulnerable a la 

erosión hídrica. Sin embargo, en marzo del 2017 se produjo el fenómeno del Niño Costero, 

que originó inundaciones extraordinarias en la región costera. Estas situaciones medio 

ambientales permitieron observar zonas sensibles a inundaciones y a la erosión hídrica, las 

cuales fueron ubicadas mediante el modelamiento geoespacial. El primer mapa elaborado 

fue el de inundaciones extraordinarias, basado en el estudio realizado por Wahid et al. en el 

2016, empleando las capas de pendientes, capacidad de infiltración, factor forma y cobertura 

donde se localizaron las zonas más propensas a ser inundadas ante precipitaciones 

extraordinarias. La superposición ponderada de dichas capas, permitió determinar que las 

áreas urbanas, el valle y los depósitos aluviales presentan una alta vulnerabilidad a 

inundaciones. Un segundo modelo de inundaciones se efectuó usando el mismo 

procedimiento, pero considerando además el factor de precipitaciones, lo que permitió una 

mejor identificación de las zonas propensas a inundaciones. El tercer modelo fue de 

vulnerabilidad física, que mostró que las zonas con vulnerabilidad alta se encuentran en la 

parte andina de la cuenca, donde las pendientes y precipitaciones son elevadas. Por último, 

se cuantificó la pérdida de suelo debido a la erosión, con ayuda de la Ecuación Universal de 

Pérdida de Suelo (USLE), la cual requirió de las variables de precipitaciones, suelos, 

pendientes y cobertura. Este modelo mostró que las zonas con mayores cantidades de pérdida 

de suelo fueron las de vulnerabilidad alta, entre 50 y 200 t/ha.año; y muy alta, mayores a 200 

t/ha.año. 

 

Palabras clave: SIG, inundaciones extraordinarias, erosión hídrica, USLE, modelo 

geoespacial, vulnerabilidad. 
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ABSTRACT 

 

The present research work was developed in the Huarmey river basin, which covers part of 

the Huarmey, Aija and Recuay provinces from the Ancash region. This basin has a coastal 

region with low rainfall, and a mountain region where heavy annual rainfall occurs, making 

this zone the most vulnerable to water erosion. However, in March 2017, the phenomenon 

known as Niño Costero occurred, which caused flash floods in the coastal region. These 

environmental situations revealed which areas were sensitive to flooding and water erosion, 

and were identified through geospatial modeling. First, the flash flood map was developed 

based on the study carried out by Wahid et al. in 2016, using the layers of slope, infiltration 

capacity, shape factor and land use/land cover to identify the areas that were most likely to 

be flooded as a result of unusually heavy rains. The result of the weighted overlay of these 

four layers established that the urban areas, the valley and the alluvial deposits presented a 

high vulnerability to these floods. A second flood model was carried out using the same 

procedure, but this time the rainfall factor was considered, allowing a better identification of 

the flood prone areas. The third model was of physical vulnerability, which showed that the 

areas with High vulnerability were located in the highlands of the basin, because of the steep 

slopes and heavy rainfall of that region. Finally, the soil loss due to erosion was quantified 

thanks to the Universal Soil Loss Equation (USLE), which required the variables of rainfall, 

soils, slopes and coverage. This model showed that the zones with the highest amounts of 

soil loss were the ones with high vulnerability, between 50 and 200 t/ha.year; and with very 

high vulnerability, greater than 200 t/ha.year. 

 

Keywords: GIS, flash floods, water erosion, USLE, geospatial model, vulnerability. 
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I. INTRODUCCIÓN 

 

En la actualidad se pueden evidenciar los diferentes efectos del cambio climático que se 

producen a nivel global, y un ejemplo de esto fue el fenómeno que se presentó en la costa 

peruana en el año 2017, donde se registró un aumento significativo de la temperatura en la 

temporada de verano y como consecuencia, las precipitaciones en esta zona del Perú 

aumentaron a niveles atípicos. De este modo, se produjo el fenómeno denominado Niño 

Costero, el cual, a diferencia del Fenómeno del Niño, este no se anuncia con anticipación, 

sino que se produce de forma repentina. Durante la temporada del Niño Costero, las 

precipitaciones se incrementaron a niveles altos en zonas donde las lluvias eran escasas, y 

esto llevó al origen de inundaciones extraordinarias y procesos de erosión del suelo, tal como 

ocurrió en la provincia de Huarmey que, en el 16 de marzo del 2017, se produjo un 

desbordamiento de agua que ocasionó fuertes desastres. Por esta razón, es que la prevención 

ante este tipo de desastres naturales es importante, para evitar mayores daños. 

 

Debido a este escenario atípico, es que se planteó la generación del modelo geoespacial de 

Inundaciones Extraordinarias, para simular que efectos puede causar este fenómeno en la 

cuenca. Utilizando el programa ArcGIS se llevó a cabo la superposición ponderada de las 

capas de pendientes, capacidad de infiltración, factor forma y cobertura para localizar las 

zonas susceptibles a precipitaciones inusuales. Esta información tiene como objetivo ser de 

utilidad para las autoridades, y les permita conocer cuáles son las regiones que requieren de 

mayor atención para el desarrollo de proyectos de prevención, y de esta forma se pueda 

aminorar el impacto ante este tipo de desastre.  De igual forma, se generó un segundo modelo 

geoespacial de inundaciones, realizando un procedimiento similar al primero, pero en este 

caso tomando en cuenta la información de las precipitaciones, para realizar un análisis entre 

el primer y segundo modelo y compararlos. 

 

Por otro lado, es importante recalcar que en la parte andina de la cuenca, las precipitaciones 

fuertes suceden anualmente, y la población tiene que lidiar con este problema de manera 

periódica. Debido a esto, se elaboró un tercer modelo geoespacial de vulnerabilidad física,  
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que mostró cuáles eran las zonas más propensas a ser afectadas por la erosión hídrica, y para 

ello se tomaron en cuenta las capas de pendientes, precipitaciones, geología, geomorfología 

y cobertura.  

 

Finalmente, se elaboró un modelo geoespacial utilizando la ecuación USLE, para cuantificar 

la pérdida de suelo anual que se producen en la cuenca por la erosión hídrica, el cual requirió 

de las variables de precipitaciones, suelos, cobertura y pendientes; y de la aplicación de 

técnicas de Sistema Información Geográfica (SIG). Estos dos últimos modelos, al igual que 

el primero es de gran importancia, ya que en este caso el escenario que se plantea sucede 

cada año.  

 

De acuerdo a lo explicado previamente, el objetivo general de esta tesis fue: 

 

Identificar las zonas vulnerables a inundaciones y procesos de erosión, y cuantificar la 

erosión hídrica en la cuenca del río Huarmey mediante el modelamiento geoespacial y uso 

del Sistema de Información Geográfica (SIG). 

 

Del mismo modo, los objetivos específicos fueron: 

 

• Elaborar una base de datos geoespacial con la información temática de capacidad de 

infiltración, cobertura, pendiente, geología, geomorfología y precipitación.   

• Realizar el modelamiento geoespacial para identificación y localización de las zonas 

vulnerables a inundaciones y erosión hídrica. 

• Identificar y cuantificar las áreas de riesgos a erosión hídrica mediante la aplicación de 

la Ecuación Universal de Pérdida de Suelos (USLE) y el Sistema de Información 

Geográfica. 
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II. REVISIÓN DE LITERATURA 

 

2.1. ANTECEDENTES  

 

El Perú por su ubicación geográfica y características morfológicas, está sujeto a la 

manifestación de diversos fenómenos naturales, entre ellos están los peligros 

hidrometeorológicos, que generan inundaciones en zonas expuestas, los cuales afectan a la 

población y sus medios de vida (CENEPRED, 2014). Las inundaciones, traen como 

consecuencia lamentables y cuantiosos decesos, miles de damnificados y significativas 

pérdidas económicas que reducen la calidad de vida y obstaculizan el desarrollo sostenible 

del país (INDECI, 2011). 

 

En el 2017, el Perú fue terriblemente golpeado por lluvias intensas, acompañadas de altas 

temperaturas del mar en la costa durante el verano y el otoño. Este evento se denominó El 

Niño Costero, que es un fenómeno nuevo, aunque similar al Fenómeno del Niño (Martínez 

y Takahashi, 2017). Este fenómeno generó lluvias costeras inusuales, las cuales conllevaron 

a los desbordes de ríos y deslizamientos de lodo y piedras, produciendo daños en las zonas 

de cultivo e infraestructura como viviendas, carreteras, puentes, canales de riego, colegios, 

hospitales, entre otros bienes públicos y privados (Aguilar y Reyes, 2017). Así mismo, las 

quebradas Río Seco, Gramadal y Huarmey se activaron y rebasaron la ciudad en pocas horas. 

Se formaron cinco huaicos que devastaron la ciudad, resultando en 425 viviendas dañadas, 

146 colapsadas y 23 inhabitables; mientras que 12 instituciones educativas también fueron 

afectadas, 11 quedaron inhabitables y otras tres colapsaron. Además, tres establecimientos 

de salud fueron inundados y a dos de ellos los declararon inhabitables (Urbina, 2017). 

 

Debido a que estos fenómenos producidos por el cambio climático se han producido en otras 

regiones, existen diversos trabajos de investigación sobre las zonas vulnerables a 

inundaciones extraordinarias en zonas donde las lluvias usualmente son escasas. Un ejemplo 

de estos estudios, fue el realizado por Wahid et al. (2016), quienes mencionan la importancia 
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de la localización de los lugares propensos a las inundaciones para evitar pérdidas 

económicas y salvaguardar a la población, así como para la planificación del uso del suelo. 

La zona de estudio de esta investigación fue en la llanura costera del sudoeste del Sinaí, 

Egipto, la cual cuenta con características geológicas, morfológicas y condiciones climáticas 

que son responsables de las inundaciones extraordinarias estacionales que pueden amenazar 

la planificación del uso del suelo en esta área. Por ello, Wahid et al. (2016) realizaron un 

trabajo de investigación para obtener un mapa de índice potencial de inundaciones, mediante 

el modelamiento geoespacial de información temática de los datos de uso de suelo/cobertura 

vegetal, capacidad de infiltración, factor forma y pendiente. En este estudio, se concluyó que 

los dos factores que más influencia tenían en el potencial de inundaciones extraordinarias 

fueron las pendientes y la capacidad de infiltración. El fin de esta investigación fue prevenir 

la pérdida de vidas, daños a la propiedad e impactos ecológicos por inundaciones, antes de 

que los planes de desarrollo se inicien en esta zona.  

   

Por otro lado, a pesar de que estos eventos extraordinarios ocasionados por el cambio 

climático deben de tomarse en cuenta para el desarrollo de modelos geoespaciales, las 

precipitaciones de altas magnitudes que se producen anualmente en la zona andina, generan 

desastres a causa de la erosión hídrica, por lo que también es de importancia la generación 

de modelos tomando en cuenta el factor de las lluvias.  

 

Los procesos de erosión del suelo pueden producirse de manera progresiva a lo largo del 

tiempo, siendo imperceptible, o de manera abrupta con una pérdida significativa de suelo en 

corto tiempo. Así mismo, la erosión puede producirse tanto de manera natural por efectos 

del agua o el viento, como por la actividad humana. Esta pérdida de suelos que se producen 

tiene como consecuencias la degradación del suelo, la reducción de la productividad agrícola 

y la contaminación de fuentes cercanas de agua (Telkar y Pote, 2014).  

 

La cuenca Huarmey está comprendida por zonas de costa y andina, donde la vegetación se 

produce a diferentes niveles. En la parte baja de la cuenca, la vegetación es escasa y la que 

existe solo depende de la zona agrícola de los valles, abarcando un área mínima. En la zona 

alta de la cuenca, es donde se encuentra la mayor vegetación de la cuenca, sin embargo, esta 

se va reduciendo cada vez más producto del sobre pastoreo y la quema de pastos, trayendo 

como consecuencia de esto una mayor erosión de los suelos (Manrique et al. 2018).  
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Existen diferentes trabajos de investigación en las cuales se han generado modelos 

geoespaciales, para determinar las zonas más vulnerables a erosión hídrica, así como para 

cuantificar la pérdida de suelo que se produce al año. Montes-León et al. (2011), realizaron 

un estudio para elaborar el Mapa Nacional de Erosión Potencial, que tuvo como finalidad 

encontrar las áreas más vulnerables de México a la erosión potencial, así como la cantidad 

de suelo que se perdía al año, utilizando las herramientas SIG y la Ecuación Universal de 

Pérdida de Suelos (USLE). La razón por la cual este mapa era de importancia, fue el registro 

de diferentes problemas surgidos a causa de la erosión hídrica. La pérdida de suelos que se 

venía produciendo en la región, originó la desaparición de zonas agrícolas, la disminución 

en los niveles de nutrientes de la tierra, daños en el área urbana donde llegaban los materiales 

acumulados, alteraciones en el ciclo hidrológico, impactos negativos en la biodiversidad y 

maltrato a las obras hidráulicas, disminuyendo su vida útil. Estas dificultades que se han 

presentado en México, debían ser atendidas, para lo cual el mapa de erosión de la zona 

permitió, además de la identificación de las zonas más susceptibles, el reconocimiento de 

los lugares donde se puedan desarrollar planes de conservación, y otros proyectos, como la 

reforestación, que disminuyan el impacto de la erosión en el ambiente (Montes-León et al. 

2011). 

 

2.2. VULNERABILIDAD 

 

En el marco de la Ley N° 29664 del Sistema Nacional de Gestión del Riesgo de Desastres y 

su Reglamento (D.S. N°048-2011-PCM) se define la vulnerabilidad como la susceptibilidad 

de la población, la estructura física o las actividades socioeconómicas, de sufrir daños por 

acción de un peligro o amenaza (CENEPRED, 2014).  

 

INDECI (2006) define la vulnerabilidad, como el grado de debilidad o exposición de un 

elemento o conjunto de elementos frente a la ocurrencia de un peligro natural o antrópico de 

una magnitud dada. Es decir, la predisposición intrínseca de como un elemento 

(infraestructura, vivienda, actividades productivas, grado de organización, sistemas de alerta 

y desarrollo político-institucional, entre otros), puede sufrir daños humanos y materiales 

cuando no se ha invertido lo suficiente en obras o acciones de prevención y mitigación y se 

ha aceptado un nivel de riesgo demasiado alto.  
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Se han establecido los siguientes tipos de vulnerabilidad: Física, ambiental y ecológica, 

económica, social, educativa, cultural e ideológica, política e institucional, y, científica y 

tecnológica (INDECI, 2011). 

 

Por otro lado, SINAGERD (2014) alerta que el 46 por ciento del territorio nacional se 

encuentra en condiciones de vulnerabilidad Alta a Muy Alta y que, además el 36.2 por ciento 

de la población nacional (9´779,370 habitantes aproximadamente) ocupan y usan este 

espacio territorial. 

 

2.3. INUNDACIÓN 

 

La inundación es un proceso de desbordamiento del agua fuera del cauce natural o artificial. 

Se producen cuando las lluvias intensas o continuas sobrepasan la capacidad de campo del 

suelo, el volumen de transporte del río es superado y el cauce principal se desborda e inunda 

los terrenos circundantes (INDECI, 2011). Según las estadísticas, el 40 por ciento de las 

víctimas por desastres naturales, se debieron por inundaciones, convirtiéndolo en uno de los 

fenómenos más letales. Esto es reforzado por el hecho de que más de la mitad de la población 

mundial vive en las costas y a lo largo de ríos y estuarios. (Martínez, 2007).  

 

El INDECI (2011), clasifica las inundaciones según su duración y su origen. Por su duración 

se clasifican como inundaciones rápidas e inundaciones estáticas; y según su origen, como 

inundaciones pluviales, inundaciones fluviales e inundaciones por operaciones incorrectas 

de obras de infraestructura hidráulica o rotura. 

 

2.4. INUNDACIÓN EXTRAORDINARIA 

 

El Servicio Meteorológico Nacional de Estados Unidos, citado por UCAR (2010), establece 

que este tipo de inundaciones se producen rápidamente con caudales muy altos y en zonas 

generalmente secas, a causa de precipitaciones intensas. Se estima que el tiempo aproximado 

que tarda en ocurrir este evento es de seis horas, aunque esto puede variar en diferentes 

lugares.  

 

Así mismo, las inundaciones extraordinarias suelen caracterizarse por las fuertes 

precipitaciones y el rápido desarrollo de escorrentía. De estos dos factores, las características 
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del suelo donde caen estas precipitaciones, son las más relevantes para el desarrollo de 

predicciones de este fenómeno (UCAR, 2010).  

 

Las propiedades del suelo como la humedad, alteraciones a la superficie, permeabilidad y 

perfil vertical; y las características de la cuenca como tamaño, forma, pendiente y cobertura 

de suelo, son las que influyen en la producción de escorrentía y por ende en la ocurrencia de 

inundaciones extraordinarias, razón por la cual forman parte de la data a tener en cuenta para 

la predicción de estos eventos (UCAR, 2010). 

 

2.5. EL NIÑO COSTERO 

 

El Niño Costero es un evento climático que, independientemente de los procesos físicos que 

lo puedan originar, está relacionado a la presencia de aguas anómalamente cálidas en forma 

persistente durante varios meses en la región del Océano Pacífico, principalmente a lo largo 

de la costa norte del Perú y de Ecuador. En algunos casos las aguas cálidas pueden extenderse 

hacia la costa central y sur del Perú. Este evento puede estar asociado a lluvias muy fuertes 

durante el verano en las zonas medias y bajas de la costa norte e inclusive de la costa central, 

así como a impactos en el ecosistema marino peruano, de acuerdo a su magnitud y 

persistencia (IMARPE, 2018). 

 

La terminología de “El Niño Costero” fue introducida formalmente por el Comité 

Multisectorial encargado del Estudio Nacional del Fenómeno El Niño (ENFEN) integrado 

por el Instituto del Mar del Perú, Servicio Nacional de Meteorología e Higrología 

(SENAMHI), Instituto Geofísico del Perú (IGP), Dirección de Hidrografía y Navegación 

(DHN), Instituto Nacional de Defensa Civil (INDECI) y la Autoridad Nacional del Agua 

(ANA) en el año 2012, con el fin de precisar las definiciones y conceptos que por años han 

causado confusión entre la población.  

 

2.6. EROSIÓN 

 

De acuerdo a Tayupanta (1993), el suelo al estar en contacto con factores externos físicos o 

químicos, puede tender a presentar cambios en la superficie, y a este desgaste del material 

del suelo se le conoce como erosión. Los suelos van perdiendo parte de su estructura durante 

el año, y esto se debe a dos factores, que son el aire y el agua (Telkar y Pote, 2014). 
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A nivel global de la superficie terrestre, existen diferentes tipos de erosión que pueden 

agruparse en seis categorías: erosión hídrica, erosión eólica, erosión fluvial, erosión marina 

y litoral, erosión glaciar y erosión kárstica (Arias, 2006). Para Kirkley y Morgan (1984); 

citado por Arias (2006), a la escala reducida de un talud y zonas aledañas, los únicos que 

revisten importancia son la erosión eólica y sobre todo la erosión hídrica. 

 

2.7. EROSIÓN HÍDRICA 

 

La erosión hídrica es el proceso de desprendimiento y arrastre acelerado de las partículas del 

suelo causado por la acción del agua que disminuye la productividad de los suelos y afecta 

la salud de los ecosistemas. La erosión hídrica es el principal problema que compromete la 

sustentabilidad de todos los sistemas productivos. La estimación de pérdidas de suelo por 

este fenómeno es una información de suma importancia para la planificación y toma de 

decisiones a diferentes niveles (Gaitán et al. 2017). 

 

Arias (2006) menciona cuatro tipos de erosión hídrica: La erosión laminar, erosión por 

arroyada anastomosada, erosión por surcos y la erosión cárcavas.  

 

• Erosión Laminar: Para Howell et al. (1979); citado por Arias (2006), consiste en la 

remoción de delgadas capas de suelo producida por el agua que fluye por terrenos 

uniformes y de poca pendiente, ocasionando la pérdida de la porción de suelo con mayor 

contenido en materia orgánica, causando un empobrecimiento en elementos nutrientes y 

un descenso de la capacidad de almacenamiento de agua.  

 

• Erosión por Arroyada Anastomosada o Trenzada: La lámina de agua no suele discurrir a 

mucha distancia, concentrándose en las pequeñas depresiones e irregularidades del 

terreno, formando pequeños hilillos de corriente no jerarquizado y de trayectoria 

cambiante, siendo sus efectos similares a los producidos por el flujo laminar. 

 

• Erosión en Regueros o Surcos: Es la forma de erosión más fácilmente perceptible, tiene 

su origen a causa del escurrimiento superficial del agua que se concentra en sitios 

irregulares o depresiones superficiales del suelo desprotegido o trabajado 

inadecuadamente (FAO, 2000; citado por Cabrejos, 2016). 
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• Erosión por Cárcavas: es el estado más avanzado de la erosión por surcos. Dependiendo 

de la pendiente y la longitud de la ladera del terreno, el flujo concentrado de agua provoca 

el aumento de las dimensiones de los surcos, hasta transformarse en zanjas de gran 

tamaño llamadas cárcavas. 

 

El proceso de erosión hídrica involucra tres etapas en las cuales se producen daños 

importantes: preparación del material (desprendimiento y remoción), transporte y 

sedimentación. 

 

En la etapa de preparación del material se produce una alteración de la estructura superficial 

del suelo, destrucción de agregados, formación de costras y sellos, alteración de la relación 

infiltración/escurrimiento y pérdida de fertilidad del suelo. En la etapa de transporte se 

completa la pérdida de las partículas del suelo (materiales coloidales como materia orgánica, 

humus, y nutrientes) iniciada en la etapa anterior, y se genera el escurrimiento superficial 

que produce distintas formas de erosión (laminar, en surcos y/o en cárcavas) y daños a la 

infraestructura. En la etapa de sedimentación el depósito del material puede destruir cultivos, 

dañar la infraestructura (caminos, vías férreas, etc.) y colmatar y reducir la capacidad de 

represas y embalses (Gaitán et al. 2017). 

 

2.8. FACTORES QUE INFLUYEN EN LA EROSIÓN HÍDRICA 

 

Entre los factores que determinan la erosión hídrica, Bascuñán (2010) menciona que son, 

tectónicos, litológicos, edafológicos, morfológicos, e incluso antrópicos, y que en conjunto 

forman un entramado complejo interdependiente a lo largo del tiempo. 

 

Morgan y Rickson, citado por Arias (2006) señalan que, a la escala reducida de un talud, y 

a corto plazo, los factores que controlan la erosión son el clima con su agresividad o 

erosividad, la naturaleza del terreno con su mayor o menor erosionabilidad, el relieve 

topográfico con su pendiente, longitud y forma de la vertiente, y la cobertura vegetal propia 

o implantada en su superficie. 

 

El análisis y la evaluación de la vulnerabilidad del territorio a los procesos erosivos y a las 

inundaciones por acción de las aguas pluviales, implica conocer las características del 
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material parental, tipos de suelos, variabilidad climática, tipos de cobertura vegetal, formas 

de relieve, pendiente, entre otros, que son los factores más importantes que determinan la 

vulnerabilidad de una zona. En tal sentido, el grado de vulnerabilidad a la erosión deberá ser 

definido sobre la base de su geología, geomorfología, suelos, clima, pendiente y cobertura 

vegetal, cuyo análisis e integración se realiza con el SIG (Montalvo, 2015). 

 

2.8.1. Precipitación 

 

Las áreas con grandes precipitaciones son propensas a ser más vulnerables que las áreas con 

baja precipitación. Para Vásquez (2000); citado por Cabrejos (2016), establece que las 

precipitaciones que se producen en una zona, guardan una fuerte relación con la escorrentía 

que se genere en el lugar, así mismo el factor viento influye en el impacto que tenga las 

precipitaciones en el suelo, ya que puede alterar la velocidad de la lluvia, variando el ángulo 

de impacto, produciéndose una fuerte erosión.  

 

2.8.2. Pendiente 

 

Es uno de los factores que valora el grado de inclinación del sustrato litológico en las 

diferentes geoformas. Se debe tener en cuenta que las zonas con poca inclinación o 

pendiente, son menos vulnerables a la erosión en comparación de las zonas con pendientes 

muy empinadas. 

 

2.8.3. Cobertura Vegetal 

 

Se debe considerar los parámetros de fisonomía, tamaño y porte de las especies que habitan 

en la unidad; así como también la cobertura, que se refiere a la densidad de especies 

vegetales, y al número de estratos. Por lo tanto, zonas de mayor cobertura arbórea y mayor 

número de estratos, son menos vulnerables a la erosión. 

 

2.8.4. Tipo de Suelos 

 

Para Vásquez (2000); citado por Cabrejos (2016), la resistencia que tenga un suelo ante el 

desprendimiento de sus partículas por efecto de fuertes escorrentías y la capacidad de 
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infiltración del suelo, será determinado por las propiedades físicas de estructura, textura, 

contenido de materia orgánica, entre otros. 

 

2.8.5. Geología 

 

Para el análisis de esta variable se debe tener en consideración el tipo de material parental, 

el ambiente de depositación, el grado de alteración, el grado de cohesión de los minerales 

que forman las rocas y en menor grado los procesos endógenos y exógenos que afectaron las 

secuencias litoestratigráficas. Debido a esto, toda zona que posee material parental 

inconsolidado es más vulnerable, ya que poseen baja estabilidad por su falta de cohesión y 

está expuesta a la constante alteración de la naturaleza. Por otra parte, las zonas con material 

más consolidado, como las rocas de alta compactación, son menos vulnerables a la erosión. 

 

2.8.6. Geomorfología 

 

Están estrechamente relacionadas con la variable geológica a través de los parámetros 

morfométricos como la declividad, amplitud altimétrica y los grados de disección, 

condicionando la acción de los procesos geodinámicos que también califican cuando 

interactúan. En el caso de la erosión, las formas de tierra tipo terrazas altas o medias son 

menos vulnerables, que las formas montañosas. Por otro lado, los relieves planos o terrazas 

bajas, cercanos a las márgenes de los ríos son más inestables por su exposición permanente 

a los fenómenos naturales como las inundaciones. 

 

2.9. SISTEMA DE INFORMACIÓN GEOGRÁFICA (SIG) 

 

Actualmente, se puede recopilar una gran cantidad de datos sobre diferentes temas, y si estos 

se encuentran georreferenciados, existe una manera eficiente de manejar esta data, la cual es 

mediante los sistemas de información geográfica.  

 

El Sistema de Información Geográfica (SIG) se define como un sistema completo, formado 

por cinco componentes (personal capacitado, datos espaciales y descriptivos, métodos 

analíticos, hardware y software), cuyo propósito es proporcionar un marco espacial para 

apoyar las decisiones para el uso inteligente de los recursos de la tierra y gestionar el entorno 

creado por el hombre (Zeiler, 1999). 
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Por otro lado, Kuroiwa (2002) menciona que los SIG están cambiando los procedimientos 

de administración de datos y los procesos analíticos, al emplearse para ayudar a la toma de 

decisiones, al proporcionar varias alternativas para la planificación del desarrollo, 

incluyendo datos socioeconómicos, la conservación del medio ambiente, y el manejo 

adecuado de los recursos del país. Afirma también que están siendo utilizados para modelar 

los peligros naturales, la vulnerabilidad y los riesgos, con resultados de suma utilidad en los 

escenarios geográficos. 

 

El software del sistema tiene la capacidad de soportar modelos o representaciones de la 

realidad atentos a puntos de vista, percepciones o intereses heterogéneos. Ello se plasmará 

tanto en la información que se seleccionará, como en la manera de organizarla en el programa 

(Moreno et al. 2008). 

 

Según Buzai (2008), son dos modelos utilizados computacionalmente para representar la 

información obtenida de las diferentes unidades espaciales: el modelo ráster y el modelo 

vectorial. 

 

El modelo ráster se caracteriza por dividir el espacio geográfico mediante una matriz 

cuadriculada, donde cada celda tiene información correspondiente a la característica 

dominante en ella. Cada celda es una localización, técnicamente se denomina píxel (picture 

element) y es la unidad mínima de representación espacial. Por otro lado, el modelo vectorial 

organiza los datos geográficos en base a la perspectiva de bases de datos relacionadas y a 

partir de esto permite trabajar digitalmente utilizando las tres entidades gráficas que se usan 

para confección de mapas: puntos, líneas y áreas. Hoy en día los SIG combinan ambos tipos 

de estructuras según la precisión de los datos con los que se va a operar. 

 

Los softwares más avanzados, como el ArcGIS, proporcionan al usuario un conjunto de 

objetos prediseñados listos para ser usados, así como también la posibilidad de desarrollar 

objetos nuevos. De esta manera se dispone de la capacidad de construir una representación 

del espacio geográfico más realista y poderosa, pero también más compleja (Zeiler, 1999); 

pudiendo desarrollar tareas tanto simples como avanzadas, incluyendo mapeo, 

administración de datos, análisis geográfico, edición de datos y geoprocesamiento. 
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2.10. TELEDETECCIÓN  

 

Cuando se quiere caracterizar alguna región de interés, se pueden realizar diferentes 

actividades, por ejemplo, un levantamiento topográfico, muestras de tipo de suelo, visitas de 

campo, entre otras muchas más. Sin embargo, cuando toda esta información va de la mano 

de una fotografía aérea o espacial de la zona de estudio, esto logra que toda la data tomada 

previamente, cobre mayor sentido, ya que estas fotografías se convierten en herramientas 

audiovisuales que permiten que cualquier usuario distinga con claridad las propiedades y 

atributos que posee la región y cómo éstas pueden variar a lo largo del tiempo.  

 

Chuvieco (1995) indicó que la definición de teledetección incluye tanto la toma de imágenes 

desde el espacio o el aire de un área de estudio, así como de los procedimientos que siguen 

para tratar dicha data según el uso que se le va a dar. Existen dos maneras de realizar una 

percepción remota, la primera es la teledetección aérea, realizada mediante aviones 

especiales y la segunda es la teledetección espacial, que es la recopilación de fotografías 

mediante sensores espaciales, siendo ésta el método más innovador. 

 

Actualmente, debido a que existe la disponibilidad de imágenes satelitales de manera 

gratuita, la percepción remota por medio de satélites es la que será definida en el presente 

estudio. 

 

De acuerdo con Labrador García et al. (2012), la teledetección espacial cuenta con siete 

componentes para su desarrollo: 

 

• El primero de éstos, es la fuente de energía que permite iluminar los elementos de 

estudio. El principal ejemplo es la radiación proveniente del sol (A).  

• El segundo, es la atmósfera, la cual es atravesada por la energía que viaja de la fuente al 

objeto de interés (B). 

• El tercero, es el conjunto de elementos sobre la superficie terrestre, que se desea 

observar. Los objetos se distinguen por la diferente radiación que refleja cada uno de 

ellos (C).  

• El cuarto es el sensor que se encuentra en el satélite, cuya función es recopilar la 

radiación reflejada (D). 
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• El quinto es la estación que recibe la data de la radiación reflejada y la procesa para 

convertirla en imágenes digitales (E). 

• El sexto elemento es el proceso para interpretar la imagen digital con el fin de obtener 

información de los objetos de interés (F). 

• El último componente consiste en la aplicación de estas imágenes para el desarrollo de 

estudios, resoluciones de problemas de la zona, etc (G). 

 

 

Figura 1: Componentes para la teledetección espacial  
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2.10.1. Radiación Electromagnética 

 

La fuente de energía al entrar en contacto con los elementos sobre la superficie terrestre, 

cada uno de estos objetos emitirá y/o reflejará una radiación electromagnética diferente, que 

se denomina signatura espectral (Castaño Fernández et al. 1996).  

 

 

Figura 2: Firmas espectrales típicas de distintas cubiertas (Fuente: Tomado de Piazzese 

y Oñate 2004) 

 

La energía electromagnética, que es emitida por los objetos, está conformada por la longitud 

de onda y la frecuencia. El espectro electromagnético es donde estos dos componentes se 

muestran de forma continua. Así mismo, las bandas espectrales son diferentes fragmentos 

del espectro, que son captados por los sensores. Debido a que el ojo humano, es un sensor, 

éste puede percibir una parte del espectro, denominada “Espectro Visible” (Schomwandt, 

2015). 

 

Según Labrador García et al. (2012), las unidades en que se mide la longitud de onda 

electromagnética son los micrómetros (μm, 10-6 m.) o nanómetros (nm, 10-9 m.). De esta 

manera, los valores de longitud de onda se reflejan en el espectro en dichas unidades, lo que 

permite su división en diferentes zonas, como la visible, ultravioleta y demás, que se 

muestran en la Figura 3. 
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Figura 3: Espectro Electromagnético (Fuente: UNAM 2016) 

 

2.10.2. Resolución de las imágenes satelitales 

 

Existen diferentes tipos de sensores espaciales, que obtienen información de la superficie 

terrestre en distintas resoluciones. Los cuatro tipos de resoluciones que posee una imagen 

satelital son la espacial, la radiométrica, la espectral y la temporal. Estas cuatro resoluciones 

permiten al usuario distinguir entre todas las imágenes que se cuente de una región de interés, 

para que utilicen las adecuadas, dependiendo de la aplicación que se les quiera dar. 

 

• Resolución Espacial: Las imágenes satelitales están compuestos por un conjunto de 

píxeles, que son la mínima unidad que capta un sensor remoto. Esta resolución indica la 

longitud que posee el píxel de la imagen. Por ejemplo, si se comparan dos imágenes, 

donde la primera cuente con una resolución de 0.5 m., que es la longitud del píxel, y la 

segunda posea una resolución de 2 m., la primera permitirá visualizar objetos más 

pequeños, que en la segunda no podrán ser identificables (Labrador García et al. 2012). 
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Figura 4: Comparación de dos imágenes con diferente resolución espacial (Fuente: 

Adaptado de SATELMAC, citado por Labrador García et al. 2012) 

 

• Resolución Radiométrica: cada sensor posee la capacidad de detectar diferentes niveles 

de radiancia espectral, es así que cuando un sensor puede captar mayores variaciones de 

radiancia, éste posee una resolución mayor que una que detecta menos variaciones. Si se 

toma como ejemplo un sistema fotográfico, su resolución radiométrica dependerá del 

número de los diferentes tonos de grises que capte el sensor (Chuvieco, 1995). Así 

mismo, en el caso de los sensores espaciales, con los que se obtiene una imagen digital, 

la resolución radiométrica depende de la cantidad de bits que se requieren para que un 

píxel sea almacenado, es así que, un sensor de 8 bits, se traduce en 28 = 256 Niveles 

Digitales que percibirá el sensor (Sarría, 2003). 

 

 

Figura 5: Comparación de resolución radiométrica (Fuente: Adaptado de Chuvieco, citado 

por Roberto et al. 2018) 
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• Resolución Espectral: este indicador permite saber cuántas bandas espectrales capta un 

sensor, así como su localización en el espectro electromagnético y el ancho de banda que 

poseen. Mientras el sensor capta un mayor número de bandas, la resolución será mejor; 

sin embargo, la elección de las bandas dependerá del uso que se les dé a las imágenes 

(Roberto et al. 2018). 

 

 

Figura 6: Comparación de bandas espectrales de diferentes sensores (Fuente: Tomado de 

Labrador García et al. 2012) 

 

• Resolución Temporal: es el tiempo que toma un sensor. para volver a tomar una imagen 

de una misma área de la superficie de la Tierra. Es el período que le toma revisitar una 

misma zona (Roberto et al. 2018). 

 

2.11. IMÁGENES SATELITALES: SENTINEL-2 

 

En este estudio se utilizaron las imágenes satelitales de Sentinel-2. De acuerdo a ESA (2012), 

el Sentinel-2 es una misión desarrollada por el programa Copernicus de la European Space 

Agency (ESA) y está conformado por dos satélites idénticos, el Sentinel-2A (lanzado el 23 

de junio del 2015) y el Sentinel-2B (lanzado el 07 de marzo del 2017), que vuelan en lados 

opuestos de la misma órbita simultáneamente. Además, cuenta con una cámara 
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multiespectral (MSI) con 13 bandas espectrales y un ancho de barrido de 290 km., cuyas 

imágenes tienen las siguientes resoluciones:  

 

• La resolución espacial de 4 bandas espectrales es de 10 m. (figura 7), la de 6 bandas es 

de 20 m. (figura 8) y la de 3 es de 60 m (figura 9).  

 

 

Figura 7: Bandas 2, 3, 4 y 8 con resolución espacial 10 m. (Fuente: Tomado de ESA 2012) 

 

 

Figura 8: Bandas 5, 6, 7, 8a, 11 y 12 con resolución espacial 20 m. (Fuente: Tomado de 

ESA 2012) 
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Figura 9: Bandas 1, 9 y 10 con resolución espacial 60 m. (Fuente: Tomado de ESA 2012) 

 

• La resolución temporal de cada satélite es de 10 días, pero en conjunto es de 5 días en la 

línea ecuatorial con condiciones climáticas de cielo despejado  

• La resolución radiométrica es de 12 bits.   

• La resolución espectral de las imágenes del Sentinel-2A y Sentinel-2B se presentan en 

la Tabla 1. 

 

Tabla 1: Resoluciones espacial y espectral de los sensores Sentinel-2 (Fuente: Tomado de 

ESA 2012) 
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Así mismo, los productos que genera Sentinel-2 han sido agrupados de acuerdo al nivel de 

procesamiento en la que se encuentra la imagen multiespectral. El Nivel-0 representa la data 

comprimida sin procesar que será la base para obtener los demás productos. Luego, se 

obtiene el Nivel-1a, que es la data sin procesar descomprimida. En el Nivel-1b, la imagen es 

corregida radiométricamente en valores de radiancia en techo de atmósfera, o Top-Of-

Atmosphere (TOA), y se provee un modelo geométrico refinado que servirá en el siguiente 

nivel de procesamiento. El producto en el Nivel-1c es una orto-imagen en la proyección 

UTM/WGS84, obtenida gracias al uso de un DEM (90 m.); además, cada banda espectral 

fue redimensionada, generando imágenes con distancias entre los centros de los píxeles 

medidos en el suelo, o Ground Sample Distance (GSD), de 10 m., 20 m. y 60 m. de acuerdo 

a la banda; de igual forma, la reflectancia por píxel es calculada en TOA (codificada en 12 

bits) y se generan las máscaras de nubes y suelo/agua (ESA, 2012). Finalmente, en el Nivel-

2a se obtiene un producto con correcciones atmosféricas, que resulta de la transformación 

de la reflectancia TOA a una reflectancia a nivel de superficie, o Bottom-Of-Atmosphere 

(BOA) de lo generado en el Nivel-1c, y de igual forma se incluye una clasificación de 

escenas (nubes, sombra de nubes, vegetación, suelos/desiertos, agua, nieve, etc.), según ESA 

(2019). Del total de productos hallados en los diferentes niveles (0, 1a, 1b, 1c y 2a), Sentinel-

2 solo pone a disposición del público las imágenes en el Nivel-1c y Nivel-2a, los cuales 

podrán ser utilizados para trabajos de gestión de riesgo, ordenamiento territorial, agricultura, 

entre otros; y en el caso del presente estudio, estas imágenes fueron empleadas para hallar la 

capa de cobertura de la cuenca Huarmey.  

 

2.12. MODELAMIENTO GEOESPACIAL 

 

El modelamiento es un procedimiento donde se realiza la integración de capas temáticas 

existentes y el diseño de un sistema para la creación de nuevos mapas, y poder efectuar un 

análisis de datos correcto. De esta manera, para realizar el modelamiento, el analista debe 

organizar los procedimientos necesarios para diseñar e identificar toda la data necesaria para 

el estudio. El modelo resultante será una representación gráfica simplificada de la realidad, 

que servirá como fuente de documentación y referencia para futuros estudios. La precisión 

del modelo final, será definida por la calidad de los datos recogidos. La principal razón para 

construir un modelo, es su uso en la predicción de eventos desconocido, por ejemplo, la 

longitud de un elemento, el cual no puede ser medido de manera directa o la condición futura 

de un fenómeno de interés (Trodd, 2005).  
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Una de las etapas más importantes en el procedimiento para construir un modelo 

geoespacial, es la identificación de factores que influyen en el estudio que se planea realizar. 

Dependiendo de cada modelo, se preparan matrices donde se representará el modo y el peso 

en el que las variables y los atributos influirán. De igual forma, se asignan calificaciones a 

los atributos de los submodelos, mediante el software del Sistema de Información Geográfica 

utilizado. (Trodd, 2005 y Rodriguez, 2007). 

 

De acuerdo con Montalvo (2015), se lleva a cabo una integración de variables en un 

esquema, tal como se muestra en la Figura 10, el cual es un ejemplo para obtener el mapa de 

vulnerabilidad. Cada variable posee un valor de acuerdo a la incidencia en el objetivo del 

modelo.  

 

 

Figura 10: Integración de variables (Fuente: Tomado de Montalvo 2015) 
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2.13. MÉTODO DE LA ECUACIÓN UNIVERSAL DE PÉRDIDA DE SUELOS 

(USLE) 

 

El Método de la Ecuación Universal de Pérdida de Suelos (Universal Soil Loss Equation, 

USLE), fue desarrollado en Estados Unidos por Wischmeier y Smith en 1965 y modificado 

en 1978. Esta ecuación evalúa principalmente la erosión laminar o erosión “entre surcos” y 

la erosión en surcos en forma conjunta, no así a la erosión por escurrimiento o “flujo 

concentrado” cuya expresión máxima es la formación de cárcavas (Marelli, 1988; citado por 

Gaitán et al. 2017).  

 

Mancilla (2008) afirma que el método USLE permite predecir la pérdida anual de suelo por 

hectárea y también precisar las técnicas más apropiadas para el laboreo del suelo, en especial 

para cultivos agrícolas. Por otro lado, Gaitán et al. (2017) menciona que la USLE es un 

método que se puede aplicar en cualquier región, de allí el termino universal, ya que 

considera los principales factores que intervienen en el proceso de erosión hídrica 

(precipitaciones, suelo, relieve, coberturas y prácticas de conservación); además permite 

predecir la erosión actual y realizar simulaciones con diferentes escenarios. 

 

La representación matemática de la Ecuación Universal de Pérdidas de Suelo es: 

 

A = R * K * L * S * C * P 

 

En donde: 

A = es la pérdida de suelo total (t/ha.año) 

R = es el índice de erosividad de la precipitación (MJ.mm/ha.h.año) 

K = es el factor de la erodabilidad del suelo (t.ha.h/ha.MJ.mm). 

L = es el factor de longitud de la pendiente 

S = es el factor de inclinación de la pendiente 

C = es el factor de la cobertura vegetal  

P = es el factor de prácticas de conservación  
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2.13.1. Factor de Precipitación (R) 

 

Este índice climático expresa la energía potencial de las precipitaciones y su escorrentía, que 

originan la erosión de una región determinada (Montes-León et al. 2011). De este modo, 

cuando las lluvias que se producen son más intensas y duran por mayor tiempo, mayor es la 

erosión potencial producida en la zona (Stone y Hilborn, citado por Chadli 2016). 

 

De acuerdo con Wischmeier y Smith, citado por Chadli (2016), este factor se obtiene de la 

multiplicación de la intensidad máxima de la precipitación en un intervalo de 30 minutos 

con la energía cinética producida. 

 

𝐸𝐼30 = 𝐸𝐶 × 𝐼30 

 

Donde: 

EI30 = Índice de erosividad de la lluvia (MJ.mm/ha.h) 

EC = Energía cinética total de la lluvia (MJ/ha) 

I30 = Máxima intensidad de la lluvia en 30 minutos (mm/h) 

 

La ecuación de Wischmeier y Smith depende de la recolección de data de intensidad de las 

lluvias en períodos corto de tiempo, sin embargo, debido a la dificultad para obtener esta 

información, se pueden utilizar otras fórmulas. Ramos Taipe (2001) indicó que el Factor R 

puede ser hallado mediante el uso de datos de precipitación anual, del mes más lluvioso o la 

máxima diaria, utilizando las siguientes fórmulas.  

 

𝑅 = 𝑎 (𝑃2/𝑃)𝑏 

 

Donde: 

P2 = Precipitación del mes más lluvioso 

P = Precipitación del año 

b = Exponente 

 

Así mismo, según Roose, citado por Ramos Taipe (2001), el Factor R se obtiene mediante 

la siguiente fórmula. 
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𝑅 = 1.73 × 0.5 × 𝑃 

 

Donde: 

R = Factor de erosividad de la lluvia (MJ.mm/ha.h.año) 

P = Precipitación media anual (mm) 

 

De acuerdo con Morgan, citado por Ramos Taipe (2001), en el caso de zonas que presentan 

altas precipitaciones, este índice se determina por la siguiente ecuación. 

 

𝑅 = 𝐼30(9.28𝑃 − 8,383)/1000 

 

Donde: 

I30 = 75 mm/h (valor recomendado por Wischmeier) 

P = Precipitación media anual (mm) 

 

Por último, este factor se puede hallar mediante la ecuación de Foster, citado por Ramos 

Taipe (2001). 

 

𝑅 = 0.276𝑃 × 𝐼30/100 

 

La elección de la ecuación a utilizar dependerá de la data de precipitaciones con la que se 

cuente. Además, Ramos Taipe (2001) señaló que las fórmulas de Roose, Morgan y Foster 

son las más recomendables, debido a que se pueden adaptar fácilmente. 

 

2.13.2. Factor de Susceptibilidad a erosión del Suelo (K) 

 

El Factor K representa la medida de la susceptibilidad a la erosión del suelo causado por 

precipitaciones y escorrentía. La textura, estructura, materia orgánica y permeabilidad del 

suelo son factores que influyen en el valor de “K”, sin embargo, la textura es la propiedad 

que tiene mayor impacto en este factor (Stone y Hilborn, citado por Chadli 2016). 

 

Un método para hallar este factor es mediante la ecuación de Wischmeier y Smith en 1978, 

la cual requiere de los datos de textura, estructura, permeabilidad y materia orgánica de los 

tipos de suelos que existan en la zona de estudio. 
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100𝐾 = 2.1𝑀1.14(10−4)(12 − 𝑎) + 3.25(𝑏 − 2) + 2.5(𝑐 − 3) 

 

Donde: 

M = (% limo + % arena muy fina) * (% limo + % arena - % arena fina) 

a = Porcentaje de materia orgánica 

b = Parámetro de tipo de estructura de suelo 

c = Clase de permeabilidad 

 

Por otro lado, Sharpley y Williams (1990), establecen que, para el cálculo del Factor K, se 

requiere solo de los datos de textura y materia orgánica y se realiza un análisis de la capa 

superior del suelo al comienzo del año de cada simulación que se realice y de acuerdo a los 

resultados que se obtengan, se efectúan las siguientes ecuaciones. 

 

𝐾𝑈𝑆𝐿𝐸 = 𝑓𝑐𝑠𝑎𝑛𝑑 × 𝑓𝑐𝑙−𝑠𝑖 × 𝑓𝑜𝑟𝑔𝑐 × 𝑓ℎ𝑖𝑠𝑎𝑛𝑑 

𝑓𝑐𝑠𝑎𝑛𝑑 = (0.2 + 0.3 × 𝑒𝑥𝑝−0.256×𝑚𝑠(1−
𝑚𝑠𝑖𝑙𝑡
100

)) 

𝑓𝑐𝑙−𝑠𝑖 = (
𝑚𝑠𝑖𝑙𝑡

𝑚𝑐 + 𝑚𝑠𝑖𝑙𝑡

)
0.3

 

𝑓𝑜𝑟𝑔𝑐 = (1 −
0.25 × 𝑜𝑟𝑔𝐶

𝑜𝑟𝑔𝐶 + 𝑒𝑥𝑝[3.72 − 2.95 × 𝑜𝑟𝑔𝐶]
) 

𝑓ℎ𝑖𝑠𝑎𝑛𝑑 = (1 −
0.7 × (1 −

𝑚𝑠

100
)

(1 −
𝑚𝑠

100
) + 𝑒𝑥𝑝[−5.51+22.9×(1−

𝑚𝑠
100

)]
) 

 

Siendo: 

KUSLE: Factor de Susceptibilidad a erosión del Suelo  

ms: Porcentaje de arena 

msilt: Porcentaje de limo 

mc: Porcentaje de arcilla 

orgC: Porcentaje de materia orgánica 
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2.13.3. Factor Topográfico (LS) 

 

Los factores de longitud de la pendiente “L” y grado de inclinación “S” expresan la 

influencia de la topografía de un lugar en la erosión hídrica (Montes-León et al. 2011). Por 

esta razón, cuando las pendientes de una región son más largas y pronunciadas, las 

probabilidades para que se produzcan erosiones son mayores (Stone y Hilborn, citado por 

Chadli 2016). 

 

De acuerdo con Desmet y Govers (1996), el cálculo de los factores LS se realiza gracias a 

un algoritmo de computadora vinculada a un software de SIG. De este modo, la ecuación 

originalmente desarrollada por Foster y Wischmeier en 1974, fue adaptada para que sea 

ejecutada con valores de una grilla de celdas, resultando en la ecuación de Desmet y Govers. 

                       

𝐿𝑆𝑗 =
𝑆𝑗(𝑗

𝑚+1 − 𝑗−1
𝑚+1)

(𝑗 − 𝑗−1)(22.13)𝑚
 

 

Donde: 

L = Factor de longitud de pendiente para el segmento j 

Sj = Factor de pendiente para el segmento j 

j = Distancia de la pendiente del segmento j (m) 

m = Exponente del factor LS de la USLE 

22.13 es la longitud de la parcela unitaria 

 

𝐿(𝑖,𝑗) =
[𝐴(𝑖,𝑗) + 𝐷2]

(𝑚+1)
− 𝐴(𝑖,𝑗)

𝑚+1

𝑥𝑚𝐷𝑚+2(22.13)𝑚
 

 

Donde: 

L(i,j) = Factor de longitud de pendiente para el píxel con coordenadas (i,j) 

A(i,j) =  Área de captación a la entrada de un píxel con coordenadas (i,j) (m2) 

D = Tamaño de píxel (m) 

m = Exponente del factor LS de la USLE 

22.13 es la longitud de la parcela unitaria 

x = Factor de corrección forma (x = 1 para sistemas pixeleados) 

 (Foster y Wischmeier, 

1974) 

 

(Desmet y Govers, 

1996) 
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Factor L 

 

Este factor mide la distancia que recorre la escorrentía, desde su origen en la divisoria de las 

aguas de la cuenca, hasta alcanzar una zona de sedimentación o cauce (Wischmeier y Smith, 

citado por González del Tánago, 1991). De este modo, es que en la realidad cuando la 

longitud recorrida por la escorrentía incrementa, se producen mayores pérdidas de suelo, y 

es en la zona baja, dónde esta pérdida aumenta, ya que la acumulación de la escorrentía 

aumenta al llegar aguas abajo (Meyer et al., citado por González del Tánago, 1991). 

  

Para efectuar la ecuación de Desmet y Govers, se requiere hallar el parámetro “m”. Según la 

metodología desarrollada por Foster et al., citada por Yaguache Ordoñez et al. (2016), para 

encontrar los valores de “m” del área de estudio se utiliza la siguiente ecuación.  

        

𝑚 =
𝛽

1 + 𝛽
 

 

Así mismo, de acuerdo a McCool et al., citado por Yaguache Ordoñez et al. (2016), la 

siguiente fórmula es aplicada para hallar “β”. 

 

𝛽 =
(

sin 𝜃
0.0896)

[3(sin 𝜃)0.8 + 0.56]
 

 

Donde: 

Θ = Pendiente del terreno  

 

Factor S 

 

El factor de inclinación de pendiente se halla mediante la relación de la pérdida de suelos en 

una pendiente determinada, entre una pendiente normalizada de nueve por ciento (Zúñiga 

Huaco, 2017). 

 

Según McCool, citado por Yaguache Ordoñez et al. (2016), las siguientes ecuaciones son 

utilizadas para hallar el factor topográfico “S”. 

 

 (Foster et al. 1977) 

 

(4) 

(McCool et al. 1987) 
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𝑆 = 10.8 sin 𝜃 + 0.03     𝑠 < 9% 

𝑆 = 16.8 sin 𝜃 − 0.50     𝑠 ≥ 9% 

 

Donde: 

S = Factor de pendiente 

Θ = Ángulo de pendiente en grados 

s = Inclinación = tan Θ 

 

Además de estas ecuaciones para el cálculo del factor topográfico, existe un método 

simplificado desarrollado por la Facultad de Hidráulica e Hidrología de la Escuela Técnica 

Superior de Ingenieros de Montes de Madrid, que permite saber el valor del Factor LS 

mediante las pendientes en porcentajes que se presentan en la zona de estudio. 

 

Tabla 2: Valores de LS de acuerdo a la pendiente (Fuente: Tomado de Ramos Taipe 2001) 

 

 

2.13.4. Factor de Cobertura Vegetal (C) 

 

Este factor refleja la capacidad de la cobertura vegetal para brindar protección al suelo, frente 

al impacto de las precipitaciones y la potencia del flujo que se producen en la superficie 

(Morante Vargas y Gonzales Carrasco, 2019). De esta manera, en las áreas que cuenten con 

una mayor cobertura vegetal, los valores de C se acercarán a cero, mientras que en las zonas 

cuya superficie se encuentra desprotegida, los valores alcanzarán el valor de uno (Montes-

León et al. 2011). 

(McCool et al. 1987) 
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Montes-León et al. (2011) realizó una compilación de diferentes valores de C para diferentes 

tipos de cobertura, consultando una variedad de bibliografías (Anexo 1). Así mismo, 

Wischmeier, citado por Ramos Taipe (2001), estableció valores del coeficiente C, para 

diversas coberturas vegetales (Anexo 2). 

 

2.13.5. Factor de Prácticas de Conservación (P) 

 

La eficiencia de las prácticas de conservación que se llevan a cabo en una región para 

controlar la erosión se expresa mediante este factor. Algunos ejemplos de estas técnicas de 

preservación son el laboreo a nivel, el aterrazado y el cultivo en fajas alternantes (Ibañes 

Asencia et al., citado por Morante Vargas y Gonzales Carrasco 2019). 

 

De acuerdo con Ramos Taipe (2001), los valores de P dependiendo de las prácticas de 

conservación obtendrán ciertos valores que se observan en el Anexo 3. Sin embargo, si no 

se cuenta con esta información o no existe la práctica de estas técnicas, P obtiene el valor de 

uno en la ecuación. 
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III. MATERIALES Y MÉTODOS 

 

3.1. UBICACIÓN DE LA ZONA DE ESTUDIO  

 

El área de estudio del presente trabajo de investigación se desarrolló en la cuenca del río 

Huarmey, la cual está ubicada en la zona noroeste del Perú, dentro de la región Áncash.  

 

La zona de estudio se encuentra entre los paralelos 9°37’16’’ y 10°11’21’’ de latitud sur, 

entre los meridianos 77°27’20’’ y 78°10’39’’ longitud oeste y su altitud varía de 0 a 4950 

m.s.n.m. Así mismo, cuenta con un área de 2,245 km2 y un perímetro de 267.2 km. 

 

Políticamente, la cuenca del río Huarmey comprende tres provincias de la región Áncash. 

La provincia de Huarmey es la que abarca mayor área de la cuenca, contando con 1,375.1 

km2, que significa un 61.3 por ciento del total; por otro lado, la provincia de Aija cuenta con 

un área de 599.1 km2, que representa el 26.7 por ciento; y finalmente, la provincia de Recuay 

abarca 270.8 km2, siendo el 12.1 por ciento del total de la cuenca. 

 

La principal vía que se utiliza para trasladarse a la cuenca, es la carretera Panamericana 

Norte, la cual conecta a la ciudad de Lima con la ciudad de Huarmey. Así mismo, esta vía 

conecta a la ciudad de Huarmey con las ciudades de Casma y Chimbote por el norte. Para 

poder trasladarse a la parte alta de la cuenca, existe una carretera asfaltada que va desde la 

ciudad de Huarmey hasta la localidad de Huamba Baja, y a partir de ahí, existe una vía no 

asfaltada para trasladarse a las demás provincias. 
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Figura 11: Ubicación de la Cuenca Huarmey 

 

 

Figura 12: División política de la Cuenca Huarmey 
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3.2. MATERIALES Y EQUIPOS 

 

A continuación, se detallará la lista de materiales que se utilizaron en el presente estudio 

para el desarrollo de los modelos. 

 

Materiales: 

• Capa vectorial de las unidades hidrográficas del Perú en formato shape del portal web 

del ANA 

• 02 imágenes satelitales de la misión Sentinel-2, desarrollada por el programa Copernicus 

de la European Space Agency (ESA), que abarca la cuenca Huarmey en su totalidad. 

• Las cartas nacionales 20-g (Culebras), 20-h (Huaraz), 20-i (Recuay), 21-g (Huarmey) y 

21-h (Huayllapampa), elaboradas por el Instituto Geográfico Nacional (IGN) en formato 

shape, que unidas contienen la información topográfica a un intervalo de 50 m. de la 

Cuenca Huarmey. 

• La capa vectorial del Mapa de Hidrogeología Nacional (2016), creado por el Instituto 

Geológico, Minero y Metalúrgico (INGEMMET) 

• Datos de precipitaciones de las estaciones climáticas de Malvas, Cotaparaco, Chamaná 

y Huarmey del Servicio Nacional de Meteorología e Hidrología del Perú (SENAMHI) 

• Las cartas nacionales 20-g, 20-h, 20-i, 21-g y 21-h de los Mapas Geológicos Integrados 

a Escala 1:100,000, elaborados entre el 2014 y 2016 por INGEMMET. 

• La capa vectorial del Mapa Geomorfológico del Perú, desarrollado por la Dirección de 

Geología Ambiental y Riesgo Geológico del INGEMMET, a escala 1:250,000, entre los 

años 2012 y 2016. 

 

Equipos:  

• Cámara digital 

• Memoria extraíble 

• GPS 

• Libreta de campo 

• Lápices, lapiceros, regla y borrador 

• Bolsas para muestras de 0.5 kg. 

• Plumón indeleble 

• Lampa 
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• Barreta 

• EPP (Guantes de seguridad, lentes de sol, zapatillas de montaña) 

• Wincha 

• Celular inteligente 

• Laptop 

• Impresora 

 

Softwares: 

• Sentinel Application Platform (SNAP) 

• ENVI 5.0 

• Google Earth Pro 

• Microsoft Office (Word y Excel) 

• ArcGIS 10.4 

 

3.3. MÉTODOS 

 

El método que se realizó consistió en cinco fases según se muestra en el siguiente gráfico. 

 

 

Figura 13: Esquema metodológico de la tesis 
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3.3.1. Fase Inicial o fase de preprocesamiento 

 

En esta primera fase, se realizó la recopilación de datos sobre la zona de estudio, necesaria 

para la elaboración de los modelos geoespaciales. 

 

a. Imágenes Satelitales: 

 

Para obtener la capa de cobertura, se requirieron de imágenes satelitales actuales, razón por 

lo que se utilizaron imágenes Sentinel-2 de alta resolución (10 m.) del área de estudio. Es 

por ello que, para obtener esta información de manera libre, se creó una cuenta de usuario 

en el sitio web Copernicus Open Access Hub (https://scihub.copernicus.eu/dhus/#/home), 

que forma parte del Programa Copernicus, desarrollado por la Unión Europea, para 

descargar de forma gratuita las imágenes Sentinel-2 y (figura 14).  

 

 

Figura 14: Sitio web Copernicus Open Access Hub (Fuente: Tomado de ESA, c2014.) 

 

Una vez que se creó la nueva cuenta de usuario, se procedió a buscar las imágenes de la 

Cuenca Huarmey. Se seleccionó un área rectangular que abarcó la cuenca en la página de 

inicio de Copernicus y se ingresaron en los filtros de búsqueda la fecha del último año y de 

la misión Sentinel-2 (figura 15). Debido a que la búsqueda de imágenes se realizó antes de 

https://scihub.copernicus.eu/dhus/#/home
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que el producto en el Nivel-2a estuviera disponible para la zona, se hizo la descarga de la 

data en el Nivel-1c, que cuenta solo con las correcciones radiométrica y geométrica pero no 

con la atmosférica. Para esta investigación se descargaron dos archivos comprimidos: 

 

• S2A_MSIL1C_20170723T152641_N0205_R025_T17LRK_20170723T152915 

archivo que pertenece al 23 de julio del 2017  

• S2A_MSIL1C_20170703T152641_N0205_R025_T17LRJ_20170703T153040 archivo 

que pertenece al 03 de julio del 2017 

 

 

Figura 15: Selección de la cuenca Huarmey y aplicación de los filtros de búsqueda 

 

Software SNAP: 

 

Para poder realizar el procesamiento de las imágenes Sentinel-2, se requirió del programa 

Sentinel Application Platform (SNAP). Según STEP (s.f.), este software de libre acceso fue 

desarrollado por ESA y dirigido por Brockmann Consult, Array Systems Computing y C-S, 

y tiene como función almacenar las herramientas para procesar las imágenes Sentinel. SNAP 

fue descargado de la página web http://step.esa.int/main/download/snap-download/, que es 

la Plataforma para la Aplicación de Herramientas Científicas, cuyas siglas en inglés son 

STEP (Anexo 4). Además, desde esta web también se descargó el procesador Sen2Cor, en 

http://step.esa.int/main/download/snap-download/
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la dirección http://step.esa.int/main/third-party-plugins-2/sen2cor/, el cual efectuó la 

corrección atmosférica de las imágenes para transformar la reflectividad de techo de 

atmósfera (TOA) a nivel de superficie (BOA) y de esta manera pasar el producto del Nivel-

1c al Nivel-2a (Anexo 5).  

 

b. Información digital de base de datos nacional: 

 

• Para la elaboración de la capa de pendientes de la zona de estudio, se requirió como 

elemento principal las curvas de nivel, las cuales se obtuvieron del aplicativo de 

descargas puesto a disposición por el Ministerio de Educación (MINEDU) a través de la 

web http://sigmed.minedu.gob.pe/descargas/#. Es por medio de este servidor, que se 

descargaron las cartas nacionales 20-g, 20-h, 20-i, 21-g y 21-h, que cubrieron toda el 

área de la cuenca. Luego de haber descargado y descomprimido los archivos en formato 

zip, se procedió a trabajar con las curvas de nivel en formato shape de cada carta. 

 

• Se requirió del Mapa de Hidrogeología Nacional, creado por el Instituto Geológico, 

Minero y Metalúrgico (INGEMMET), cuya última actualización fue en el 2016. Esta 

información se obtuvo del portal GEOCATMIN, el cual es un Sistema de Información 

Geológico y Catastral Minero donde se encuentra una base de datos del territorio 

nacional (INGEMMET, c.2017). Desde este servidor, se descargó un archivo en formato 

shape del Mapa de Hidrogeología. 

 

• Se utilizó el visor de estaciones que se encuentra en el portal web del ANA 

(http://snirh.ana.gob.pe/visors2/), ya que contiene los datos de precipitaciones del 

SENAMHI, para descargar información de las estaciones climáticas de Malvas, 

Cotaparaco, Chamana y Huarmey por un período de 21 años (1990-2010). 

 

• Se utilizó el portal GEOCATMIN (http://geocatmin.ingemmet.gob.pe/geocatmin/) para 

la descarga de los archivos en formato shape de las cartas nacionales 20-g, 20-h, 20-i, 

21-g y 21-h de los Mapas Geológicos Integrados a Escala 1:100,000, elaborados entre el 

2014 y 2016 por INGEMMET. 

http://step.esa.int/main/third-party-plugins-2/sen2cor/
http://snirh.ana.gob.pe/visors2/
http://geocatmin.ingemmet.gob.pe/geocatmin/
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• Se obtuvo el Mapa Geomorfológico del Perú, desarrollado por el INGEMMET, mediante 

el portal GEOCATMIN, donde se descargó un archivo en formato shape del mapa 

completo. 

 

c. Coordinación para visita de campo: 

 

Se concertaron reuniones con el director de la Agencia Agraria de Huarmey, el Ing. Efraín 

Tito Motta Padilla, para explicarle el proyecto de tesis y elaborar el plan de visita a la cuenca. 

 

3.3.2. 1ra fase de Geoprocesamiento 

 

En esta etapa se realizó el procesamiento de las imágenes e información digital de la cuenca 

Huarmey para la elaboración de la información temática de cobertura, pendiente, capacidad 

de infiltración, geología, geomorfología, factor forma y precipitación. 

 

a. Cobertura Vegetal 

 

Delimitación de la imagen satelital 

 

En este mapa temático se podrá visualizar la clasificación de uso de suelo, y la cobertura 

vegetal, que representa las formaciones naturales que están sobre la superficie. Debido a que 

este mapa puede ser utilizado para diferentes propósitos, no existe una clasificación 

estandarizada, por lo que para cada estudio se llevará a cabo una distribución acorde a las 

necesidades (Anderson et al. 1976). 

 

Una vez efectuada la descarga de las imágenes satelitales Sentinel-2, se procedió a ejecutar 

la corrección atmosférica para que pasen del Nivel-1c al Nivel-2a, por lo cual se utilizó el 

programa SNAP y la herramienta Sen2Cor. Las dos imágenes descargadas (la primera del 

23 de julio del 2017 y la segunda del 03 de julio del 2017) fueron descomprimidas y dentro 

de la carpeta se encontraron diferentes archivos (Anexo 6). El archivo de metadatos, 

MTD_MSIL1C en formato XML, de cada producto se abrió en el programa SNAP, ya que 

dentro de ellos se encontraban las 13 bandas espectrales (figura 16). 
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Figura 16: Archivos abiertos en SNAP 

 

Después se procedió a usar el procesador Sen2Cor, que efectuó la corrección atmosférica 

para alcanzar el Nivel-2a, en esta ventana se seleccionó el primer archivo y en la sección de 

Parámetros para Procesamiento se escogió la resolución en la que se quiso obtener el 

resultado, que en este estudio fue de 10 m., con el fin de conseguir una imagen de alta 

resolución que permita una mejor clasificación de clases (Anexo 7). Una vez terminado el 

proceso de corrección, las imágenes logradas en el Nivel-2a (figura 17) se guardaron en la 

misma carpeta donde se encontraban los archivos originales. Este proceso se repite para el 

segundo archivo. 
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Figura 17: Imagen corregida 

 

Las bandas 2, 3, 4 y 8 que cuentan con una resolución de 10 m. fueron las que se utilizaron 

para los pasos siguiente; sin embargo, las demás bandas que cuentan con una resolución de 

20 m. y 60 m., también pueden emplearse, luego de pasar por un proceso de remuestreo 

gracias a la opción Resampling que ofrece SNAP, donde se puede cambiar la resolución de 

estas bandas a 10 m. 

 

Después de los procesos anteriores, se efectuó el mosaico de las dos imágenes que cubren la 

cuenca Huarmey ya en el Nivel-2a. Ambos archivos de metadatos (MTD_MSIL2A) fueron 

exportados en el formato original de SNAP, BEAM-DIMAP, que permite que el 

procesamiento no tarde demasiado por no contar con memoria suficiente en el ordenador 

(Casella et al. 2018). Estos nuevos archivos, se abrieron en SNAP y se seleccionó la 

operación Mosaicing.  

 

En la primera pestaña de la ventana de Mosaicing, se ingresaron los datos de entrada, los 

cuales fueron las dos imágenes a unir; y los parámetros de salida fueron, la ruta del archivo 

resultante, el nombre, y el formato. 
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En la pestaña de Map Projection Definition, se escogió la opción de UTM/WGS 84 

(automático), se indicó que el tamaño del píxel resultante fuera de 10 m. y en el mapa 

mundial que se muestra, se encerró en un recuadro los límites donde se encuentra el mosaico.  

 

Por último, en la tercera pestaña de Variables y Condiciones se añadieron las bandas a 

mostrarse en el producto final, que en este caso fueron las bandas 2, 3, 4 y 8, para finalmente 

correr el procesamiento con el comando Run (Anexo 8).   

 

 

Figura 18: Mosaico final 

 

Una vez que se contó con el mosaico final (figura 18), se procedió con la extracción de la 

cuenca Huarmey, razón por la que se importó al SNAP el archivo en formato shape de la 

cuenca, apareciendo como una máscara sobre el mosaico. Luego, se abrió la ventana de 

Land/Sea Mask cuya función es igualar a cero el valor de los píxeles fuera de la región de 

interés (ROI), que en este caso fue el polígono de la cuenca. En la primera pestaña se 

ingresaron los datos de entrada/salida y en la segunda se seleccionaron las bandas que 

conformaron la imagen resultante (2, 3, 4 y 8) y el vector que se usó como máscara (Anexo 

9). Finalmente se corrió el procesamiento dando como producto la imagen satelital 

delimitada (figura 19). Este archivo final se exportó en formato ENVI, para que en ese 

software pueda ser clasificado, esto a causa de que el ordenador donde se realizó este estudio 
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no tuvo la capacidad para procesar las clasificaciones supervisadas y no supervisadas en el 

programa SNAP. 

 

 

Figura 19: Imagen Satelital de la cuenca Huarmey delimitada 

 

Clasificación No Supervisada y Supervisada 

 

Después de obtener la imagen satelital delimitada de la cuenca del río Huarmey, se hizo uso 

del software ENVI para la clasificación de coberturas. En este programa se realizaron dos 

tipos de clasificación, la supervisada y no supervisada.  

 

Durante este proceso, se encuentran zonas con características similares para que sean 

agrupadas en clases, de este modo, se inició con una clasificación no supervisada K-Means 

o K-Medias, que realizó este procedimiento de manera automática, solo necesitando los 

datos de la imagen de entrada, los números de clases y el nombre del archivo de salida, 

resultando en la imagen de la figura 77.  

 

Después, se llevó a cabo la clasificación supervisada que, a diferencia de la no supervisada, 

realiza una agrupación de forma controlada. Para ello, se utilizaron imágenes de Google 

Earth, y la imagen satelital delimitada en infrarrojo (para localizar las áreas verdes). 
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La clasificación supervisada comienza con la definición de los ROI’s o también llamados 

regiones de interés, para lo cual se abrió la herramienta ROI y se dibujaron los polígonos de 

cada zona en la imagen, los cuales resultaron en 11 clases (Anexo 10). Una vez que se obtuvo 

el archivo de clases, se probó con diferentes métodos de clasificación supervisada que cuenta 

el programa ENVI, siendo la clasificación por Máxima Probabilidad (Maximum Likelihood), 

por la que se optó en este estudio, y la cual generó el gráfico de la figura 78. 

 

Luego de realizar la clasificación supervisada por Máxima Probabilidad, se observó en la 

imagen resultante que aún existían algunos errores en la distribución de las zonas. Debido a 

esto, se efectuaron algunas correcciones, con el fin de obtener una mayor precisión en el 

mapa de cobertura. Para ello, se utilizó el TIN elaborado para este estudio y se realizaron 

visitas de campo a la zona urbana, agrícola, llanuras, entre otras de la cuenca Huarmey, para 

poder fotografiar las diferentes coberturas encontradas, así como para tomar las coordenadas 

mediante un GPS, para asignar la ubicación de los lugares en donde se tomaron las 

fotografías (figura 20, 21, 22, 23, 24 y 25). Por otro lado, en las áreas que fueron inaccesibles, 

debido a la falta de carreteras, se emplearon las imágenes satelitales provistas por Google 

Earth Pro (figura 26).  

 

 

Figura 20: Llanura arenosa 
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Figura 21: Áreas agrícolas 

 

 

Figura 22: Matorrales  
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Figura 23: Montañas  

 

 

Figura 24: Suelo desnudo 
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Figura 25: Zonas urbanas 

 

 

Figura 26: Cuenca Huarmey en Google Earth Pro (Fuente: Tomado de Google, c2019.) 
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b. Pendiente 

 

Se utilizó el componente ArcMap del software ArcGIS, como medio para trabajar con los 

archivos descargados de las cartas nacionales. Se inició agregando las curvas de nivel de 

todas las cartas al ArcMap, sin embargo, en este caso se observó que la cuenca se encontraba 

dentro de las zonas 17 y 18 sur en la proyección UTM. Para continuar con los siguientes 

procesos, se necesitaba trabajar en un sistema definido de coordenadas, para lo cual se eligió 

la zona 18 sur, ya que la mayor parte de la cuenca recae en esta área (figura 27). Una vez 

realizado este análisis, se hizo el cambio de sistema de coordenadas de las cartas 20-g y 21-

g de la zona 17 sur, con la herramienta Project de ArcGIS, cuya ruta es ArcToolbox > Data 

Management Tools > Projections and Transformations > Project. En esta ventana se 

agregó el archivo en formato shape de la carta a transformar, el programa por defecto detectó 

el sistema en el que se encontraba; luego se agregó la ubicación del resultado, se seleccionó 

el nuevo sistema de coordenadas, que en este caso fue WGS 1984 UTM Zona 18S, y se 

corrió el programa. El mismo proceso se realizó para la segunda carta.    

 

 

Figura 27: Zonas en la que recae la cuenca Huarmey 
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Antes de seguir con los siguientes pasos, se definieron las propiedades del Marco de Datos 

(Data Frame Properties) de ArcMap, que luego del análisis previo, se definió la zona 18 Sur 

como el sistema de coordenadas. Después de esto, el siguiente paso fue combinar las cinco 

capas vectoriales de las curvas de nivel con la herramienta Fusionar (Merge), ubicado en la 

opción de Geoprocesamientos (Geoprocessing) de la barra de herramientas. En esta ventana 

se agregaron las cinco capas de las curvas de nivel y se añadió la ubicación del archivo de 

salida. Luego de conseguir el resultado, se procedió a cortar las curvas en forma de un 

polígono que encerraba el área de la cuenca, esto con ayuda de la herramienta Recortar 

(Clip), que también se encuentra en Geoprocessing. La razón por la cual no se cortaron las 

líneas de las curvas de nivel con la forma de la cuenca de estudio, fue porque los bordes 

irregulares de este polígono generaron imprecisiones en la creación de las redes irregulares 

de triángulos (TIN).  

 

La elaboración del TIN se llevó a cabo con la herramienta Crear TIN (Create TIN), cuya 

dirección es ArcToolbox > 3D Analyst Tools > Data Management > TIN > Create TIN. 

En esta ventana se añadió la capa de las curvas delimitadas, se escogió el sistema de 

coordenadas del TIN, zona 18 Sur, luego se ingresó la ubicación del producto de salida y en 

las características del archivo de entrada se seleccionó el campo donde se encontraban las 

alturas de las curvas de nivel en la Tabla de Atributos, que en el caso de las cartas del IGN 

es el campo “Z” (figura 28). El resultado muestra la forma del relieve de la cuenca Huarmey 

y se puede observar en la figura 29. 

 



49 

 

 

Figura 28: Ventana para crear el TIN 

 

 

Figura 29: TIN resultante 
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Después, se efectuó una interpolación del TIN obtenido, para generar un Modelo Digital de 

Elevaciones (DEM), con la herramienta TIN a Ráster, que se encontró en la ruta ArcToolbox 

> 3D Analyst Tools > Conversion > From TIN > TIN to Raster. Como datos de entrada, 

se añadió el TIN y se especificó que el tamaño de celda fuera de 30 m. (este tamaño fue 

utilizado en todos los ráster del proyecto). Como dato de salida, se agregó la ruta de salida 

del DEM (figura 30). El resultado fue un ráster que representa la superficie del suelo (figura 

31). Ya que el DEM se elaboró de forma correcta, en este punto se delimitó el DEM con la 

forma de la cuenca Huarmey con ayuda de la herramienta Extraer por Máscara (Extract by 

Mask), el cual tiene la ruta ArcToolbox > Spatial Analyst Tools > Extraction > Extract 

by Mask, en esta ventana se agregó el ráster resultante, el polígono de la cuenca en formato 

shape y la ubicación que se dio al DEM de Huarmey (figura 32).    

 

 

Figura 30: Ventana TIN a Ráster 
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Figura 31: Primer DEM resultante 

 

 

Figura 32: DEM de la cuenca Huarmey 
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Los sumideros son errores comunes que puede presentar un DEM, es por esta razón que, 

como solución ante este posible escenario, se aplicó la función Rellenar (Fill), que se 

encontró en la ruta ArcToolbox > Spatial Analyst Tools > Hydrology > Fill. Este nuevo 

ráster corregido se utilizó para hallar las pendientes de la superficie, para lo cual se empleó 

la herramienta Pendiente (Slope), localizada en la dirección ArcToolbox > Spatial Analyst 

Tools > Surface > Slope. Para el presente estudio, se necesitó un mapa de pendientes con 

las unidades de medidas en porcentaje, por lo cual en la ventana Slope se ingresaron los datos 

del ráster corregido, la ruta de salida y se especificó la unidad de medida en porcentaje 

(figura 33).  

 

 

Figura 33: Ventana de la herramienta Slope 

 

c. Capacidad de Infiltración 

 

Luego de haber descargado el Mapa de Hidrogeología Nacional del INGEMMET en formato 

shape, se procedió a utilizar la herramienta Clip de la opción Geoprocessing, en el programa 

ArcGIS, para delimitar los datos a la cuenca hidrográfica en estudio. Una vez que se obtuvo 

la capa de capacidad de infiltración delimitada, se realizó una comparación con los Mapas 

Geológicos Integrados y el TIN de la cuenca, donde se mostraba que algunas áreas de los 

tipos de suelo requerían modificaciones en su delimitación, razón por la cual se procedió a 

efectuar estas correcciones. Esta nueva capa corregida contó con una tabla de atributos que 

indicaba el tipo de permeabilidad que existía en los grupos de suelo de la zona de estudio. 

Según el nivel de la capacidad de infiltración, se clasificaron los tipos de suelo en los grupos 
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A, B y C; donde A representa el mayor nivel de infiltración, B el nivel medio de infiltración 

y C la más baja. 

 

d. Geología 

 

Una vez que se descargaron las cartas nacionales 20-g, 20-h, 20-i, 21-g y 21-h de los Mapas 

Geológicos Integrados en formato shape del portal GEOCATMIN, se procedió con el 

cambio del sistema de coordenadas de las cartas que se encontraban en la zona 17 sur de la 

proyección UTM, a la zona 18 sur, como se realizó para las curvas de nivel. Luego, estas 

cartas fueron fusionadas con la opción Merge de Geoprocessing y después se utilizó la 

herramienta Clip para delimitar los datos a la cuenca Huarmey. Finalmente, con la función 

Dissolve se simplificaron los datos de la capa de geología, que resultó en ocho unidades 

geológicas. 

 

Unidades Geológicas de la Cuenca Huarmey 

 

− Batolito de la Costa:  

Está conformado por una masa de rocas ígneas de tipo plutónicas, compuesto por dioritas, 

tonalitas, gabros, granodioritas y monzogranitos. Forma parte del período Cretácico Superior 

– Paleógeno. Se presentan en forma de colinas y montañas a los lados del río Huarmey, entre 

las localidades de Tayca y Huamba, las cuales se ubican en la zona media de la cuenca. 

Debido a que en estas unidades geológicas se pueden encontrar fracturas de gran intensidad, 

son consideradas de gran riesgo, ya que son susceptibles a movimientos sísmicos, así como 

a erosiones hídricas, tal y como ocurrió en marzo del 2017, donde se produjeron derrumbes 

en este sector (Concha Niño de Guzmán et al. 2017). 

 

− Depósito Aluvial:  

Estas formaciones geológicas, pertenece al período Cuaternario y están localizadas en el 

valle de la cuenca, así como en las quebradas de esta, formando abanicos en algunas zonas. 

La mayor parte de esta unidad se presenta como rocas ígneas intrusivas en fracciones sub-

redondeadas, y el resto como rocas sedimentarias como calizas y areniscas. Durante el 

fenómeno del Niño Costero, estos depósitos fueron afectados por las precipitaciones 

extraordinarias, los cuales generaron movimientos de masa de agua con detritos (huaycos) 

en esta zona (Concha Niño de Guzmán et al. 2017). 
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− Formación Chimú:  

La edad de esta unidad es del Valanginiano inferior y ocupa un área pequeña en la parte 

superior de la cuenca. Se conforma por rocas sedimentarias, tales como ortocuarcitas, 

areniscas e intercalaciones de lutitas negras y capas de carbón antracítico (INGEMMET, 

1995). 

 

− Formación Junco:  

Esta unidad pertenece al Cretácico Inferior y está compuesta principalmente por lavas 

almohadilladas, y en menor proporción por brechas sedimentarias. A pesar de que se 

desarrollaron flujos de detritos en Tayca y Monsalve, esta formación geológica no presentó 

derrumbes de gran magnitud durante los eventos del Fenómeno del Niño Costero (ATDR 

Casma-Huarmey, 2007; Concha Niño de Guzmán et al. 2017). 

 

− Formación La Zorra:  

Se encuentra ubicado en la zona costera de la cuenca Huarmey y pertenece a la edad Albiano 

medio a superior. Esta unidad presenta flujos piroclásticos, asimismo una intercalación de 

rocas sedimentarias e ígneas como las limolitas y andesitas, y finalmente cuenta con las rocas 

sedimentarias calizas y areniscas. Se encuentra sobre la Formación Junco y bajo la 

Formación Lupín. Durante las precipitaciones de marzo del 2017, no se produjeron mayores 

cambios en esta unidad, sin embargo, los depósitos cuaternarios ubicados sobre esta 

formación presentaron deslizamientos (Concha Niño de Guzmán et al. 2017). 

 

− Formación Lupín:  

Tiene una edad del Cretáceo Superior, y aflora en la zona media y baja de la cuenca 

Huarmey. Está compuesto principalmente por lavas almohadilladas y brechas, y en menor 

proporción de tufo andesítico. Esta unidad permaneció estable cuando se presentó el 

Fenómeno del Niño Costero en 2017 (ATDR Casma-Huarmey, 2007; Concha Niño de 

Guzmán et al. 2017). 

 

− Formación Santa, Carhuaz:  

Estas formaciones integran el Grupo Goyllarisquizga. La Formación Santa forma parte del 

período Valanginiano medio a superior y está compuesta por rocas sedimentarias, tales como 



55 

 

las calizas y lutitas calcáreas abigarradas, de igual forma presenta calizas negras, margas y 

lutitas oscuras. Por otro lado, la Formación Carhuaz sobreyace la Formación Santa y tiene 

una edad de Valanginiano superior. En la parte inferior de esta formación existe una 

composición donde predomina la arcilla y está compuesta por intercalaciones de rocas 

sedimentarias como las lutitas fosilíferas con areniscas, calizas y yeso. Así mismo, la parte 

superior se caracteriza por el color pardo rojizo de las areniscas y presenta lutitas y lutitas 

arenosas (INGEMMET, 1995). 

 

− Grupo Calipuy 

Ubicado en la parte superior de la cuenca Huarmey, abarcando la Cordillera Negra de 

Áncash. Forma parte del período tardío del Terciario Inferior. Esta unidad también llamada 

Volcánico Calipuy está compuesta principalmente por lavas andesíticas, toba volcánica, 

piroclastos, aglomerados y lavas ácidas, así también de cuerpos intrusitos subvolcánico. Esta 

unidad no presentó alteraciones durante las precipitaciones en marzo del 2017 (ATDR 

Casma-Huarmey, 2007; Concha Niño de Guzmán et al. 2017). 

 

e. Geomorfología 

 

El archivo shape del Mapa Geomorfológico del Perú se agregó al marco da datos (Data 

Frame) de ArcMap para que sea recortado con la herramienta Clip de la opción 

Geoprocessing, de acuerdo al área de estudio. A la capa resultante, se le aplicó la función 

Dissolve, y esto dio como resultado cinco unidades geomorfológicas. 

 

Unidades Geomorfológicas de la Cuenca Huarmey 

 

− Colinas y lomadas 

Se localizan en la parte media baja de la cuenca, a ambos lados del valle, con elevaciones 

que van de 50 a 300 m. y pendientes suaves. Así mismo, presentan cumbres y laderas 

redondeadas. Esta unidad presenta rocas intrusivas, volcánicas y sedimentarias, las cuales 

pueden ser vulnerables a movimientos en masa, deslizamientos o derrumbes, dependiendo 

de su composición, grado de fracturamiento y exposición ante efectos climáticos (erosión o 

meteorización) (Zavala et al. 2009). 
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− Mantos de arena 

Se originan por la migración y acumulación de arena debido a procesos eólicos y la 

geomorfología de la zona, y pueden presentar formas alargadas, onduladas o de dunas. En 

la cuenca de estudio, los mantos se encuentran adyacentes a las colinas (Zavala et al. 2009). 

 

− Montaña con pendientes suaves a moderadas 

Se encuentra distribuida a lo largo de la cuenca, con pendientes de 15° a 29°, y están 

localizadas adyacente a montañas estructurales de laderas escarpadas. El relieve de las 

montañas está relacionado con la formación de cárcavas, derrumbes y huaycos. Las rocas 

intrusivas que se presentan en esta unidad pueden ser vulnerables a movimientos de masa 

(Zavala et al. 2009). 

 

− Montaña con pendientes moderadas a fuertes 

En esta unidad existen laderas que van de moderadas a fuertes, no menores a 30° y llegando 

a superar los 70°. Se localizan a partir de la parte media a la parte alta de la cuenca y presenta 

rocas intrusivas, sedimentarias y volcano-sedimentarias. En esta zona existe la posibilidad 

de caídas de rocas, deslizamientos, derrumbes y avalanchas de detritos (Zavala et al. 2009). 

 

− Terraza aluvial 

Esta unidad está ubicada sobre el cauce y la zona de inundación fluvial, y está rodeada por 

los valles de la cuenca. Esta unidad presenta una superficie plana, con pendientes de 1° a 5°, 

y depósitos aluviales en forma de terrazas. Es susceptible a inundaciones periódicas, así 

como erosión y derrumbes en los márgenes (Zavala et al. 2009). 

 

f. Factor Forma 

 

Şen (2008) indicó que el factor forma presenta una relación con la cantidad de escorrentía 

que se da en la cuenca, al igual que con la formación de inundaciones. Así mismo, en el caso 

de que existan dos cuencas con una misma área, la cuenca con forma más alargada tendrá 

un caudal máximo menor, que la cuenca con una forma más redonda. Debido a lo explicado, 

es que se requirió de esta capa y para ello se utilizó la fórmula de factor forma propuesto por 

Horton. 
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𝐾𝑓 =
𝐴

𝐿2
 

 

Donde: 

Kf: Factor forma 

A: Área de la cuenca (km2) 

L: Longitud de la cuenca (km) 

 

El procedimiento comenzó con la delimitación de las subcuencas de la zona de estudio. Para 

esto, se requirió del DEM corregido con la herramienta Fill, elaborado previamente para el 

mapa de pendientes y de las herramientas de Hidrología (Hydrology) del software ArcGIS. 

Como primer paso, se utilizó el ráster “Fill_Hy”, para hallar la dirección de flujo de cada 

celda con la opción Flow Direction, que se encontró en la ruta ArcToolbox > Spatial 

Analyst Tools > Hydrology > Flow Direction, donde se ingresó el archivo “Fill_Hy” y la 

dirección del archivo de salida (figura 34). El ráster generado, “Flow_Dir”, se observa en la 

figura 35.     

 

 

Figura 34: Ventana de Flow Direction 
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Figura 35: Ráster de Flow Direction 

 

Luego, se hallaron las acumulaciones de flujo de cada celda con la función Flow 

Accumulation (figura 36), localizado en la ruta ArcToolbox > Spatial Analyst Tools > 

Hydrology > Flow Accumulation, en esta ventana se ingresaron el ráster de dirección de 

flujo y el nombre del archivo resultante, que fue “Flow_Acc” (figura 37). El ráster que se 

obtuvo se muestra en la figura 38. 

 

 

Figura 36: Determinación de acumulación de flujo (Fuente: Tomado de ESRI s.f.) 
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Figura 37: Ventana de Flow Accumulation 

 

 

Figura 38: Ráster de Flow Accumulation 
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A continuación, se procedió con la identificación de las redes de drenaje, que se realizó 

mediante la Calculadora de Ráster (Raster Calculator), cuya función fue determinar la red 

de flujo utilizando una expresión condicional, donde las celdas que tuvieron una 

acumulación de flujo con valores mayores a 20,000 (valor adecuado para este estudio), 

equivalieron a uno y el resto de celdas que no cumplían con esta condición, se dio un valor 

de cero (figura 39). Esta herramienta se encontró en la dirección ArcToolbox > Spatial 

Analyst Tools > Map Algebra > Raster Calculator. El presente cálculo dio como resultado 

el ráster de la figura 40. 

 

 

Figura 39: Ventana de Raster Calculator 
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Figura 40: Ráster de Red de drenaje de la cuenca Huarmey 

 

Después, las redes de drenaje fueron transformadas de un formato ráster a un formato shape, 

para lo cual se usó la herramienta De Corriente a Entidad (Stream to Feature), que se 

encontró en la ruta ArcToolbox > Spatial Analyst Tools > Hydrology > Stream To 

Feature. En esta ventana se añadieron los datos del ráster de redes de drenaje, calculados 

anteriormente; el ráster de dirección de flujo y la ubicación del shape de salida (figura 41). 

El archivo de polilínea de las redes de drenajes se puede ver en la figura 42. 
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Figura 41: Ventana de Stream To Feature 

 

 

Figura 42: Shape de red de drenaje 
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Este archivo de polilínea de los arroyos sirvió para hallar los puntos de desfogue de las 

subcuencas de la zona de estudio. Por medio de la función De Vértices de Entidad a Puntos 

(Feature Vertices To Points), ubicado en ArcToolbox > Data Management Tools > 

Features > Feature Vertices To Points, se transformaron los vértices donde terminan las 

redes, en un nuevo archivo de puntos que representan los puntos de salida de las subcuencas. 

Para ello, se requirió del shape de red de drenaje, llamado “StreamToFea20000”, la ruta de 

salida de los puntos y la selección del tipo de vértice que generaran los puntos, que en este 

caso es el vértice final (figura 43). El resultado se puede ver en la figura 44.  

 

 

Figura 43: Ventana de Feature Vertices To Points 
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Figura 44: Puntos de desfogue 

 

Como siguiente paso, se procedió con la delimitación de las subcuencas de la zona de 

estudio, para lo cual se utilizó la herramienta Cuenca Hidrográfica (Watershed), cuya ruta 

es ArcToolbox > Spatial Analyst Tools > Hydrology > Watershed. Para ejecutar esta 

función, se añadieron el ráster de dirección de flujo, el archivo de los puntos de desfogue y 

la ubicación del archivo de salida (figura 45). Las subcuencas delimitadas se muestran en la 

figura 46. 
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Figura 45: Ventana de Watershed 

 

 

Figura 46: Ráster de las subcuencas de Huarmey 
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Finalmente, se halló el parámetro de factor forma para cada subcuenca. Para realizar este 

cálculo, se tuvo que convertir el ráster de subcuencas en un archivo de formato shape (figura 

47), con el fin de determinar las longitudes y áreas de las cuencas. Las longitudes (del punto 

de desfogue al punto más lejano de la línea divisoria de aguas), se hallaron con la herramienta 

Medir (Measure) de ArcGIS, y las áreas, con la función Calcular Geometría (Calculate 

Geometry), ubicado en la Tabla de Atributos del archivo shape; ambos datos se calcularon 

en km y km2, respectivamente.  

 

 

Figura 47: Shape de las subcuencas de Huarmey 

 

Luego, el factor forma de cada unidad hidrográfica se encontró con la función Calculadora 

de Campo (Field Calculator), donde se ingresó la división del área entre la longitud al 

cuadrado (figura 48). A los valores resultantes de las subcuencas, se les asignaron la forma 

correspondiente de acuerdo a la Tabla 3. 
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Tabla 3: Forma de la cuenca según los valores de Factor Forma (Fuente: Tomado de 

Pérez, citado por Córdova 2016) 

 

 

 

Figura 48: Resultados en la tabla de atributos 
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g. Precipitación 

 

El Mapa de Precipitaciones se desarrolló gracias a los datos de SENAMHI. Las estaciones 

climáticas de Malvas, Cotaparaco, Chamana y Huarmey fueron las que se utilizaron, y el 

período de tiempo en que los datos fueron recolectados fue de 21 años (1990-2010). Estos 

valores fueron ordenados en una hoja Excel, sin embargo, debido a la falta de data de 

precipitaciones (PP) que se presentaron en algunos meses de las estaciones, se utilizó el 

método de Regresión Lineal para completar la información faltante (Tabla 4).  

 

Tabla 4: Datos completos por método de Regresión Lineal 

AÑO 

PP de Estaciones (mm) PP media 

anual 

(mm) MALVAS COTAPARACO CHAMANA HUARMEY 

1990 233.80 269.70 46.30 1.28 137.77 

1991 370.20 229.00 28.00 0.78 156.99 

1992 238.30 142.70 30.10 0.83 102.98 

1993 551.70 718.86 219.40 6.08 374.01 

1994 518.80 337.50 100.90 2.80 240.00 

1995 251.80 278.80 60.00 1.66 148.07 

1996 393.80 366.00 105.60 2.93 217.08 

1997 550.40 398.00 124.60 3.45 269.11 

1998 862.50 671.70 339.70 9.42 470.83 

1999 664.70 500.64 219.80 6.09 347.81 

2000 567.10 486.20 128.54 2.70 296.14 

2001 559.10 498.70 144.74 1.60 301.03 

2002 517.44 455.30 103.90 1.00 269.41 

2003 324.50 349.80 79.31 11.20 191.20 

2004 343.80 259.86 52.70 1.46 164.45 

2005 278.77 202.50 27.30 1.70 127.57 

2006 510.40 407.47 74.50 0.20 248.14 

2007 402.90 347.10 90.21 3.00 210.80 

2008 562.80 410.60 119.38 0.90 273.42 

2009 614.10 523.10 147.91 4.10 322.30 

2010 333.50 405.37 115.77 2.20 214.21 
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Luego, con el fin de determinar si es que existen inconsistencias en los datos estimados, se 

realizó un análisis de curva de doble masa entre los valores acumulados de las 

precipitaciones anuales, con los promedios acumulados (Tabla 5). Esta comparación de 

datos, generó líneas rectas consistentes, las cuales indicaron una proporcionalidad entre los 

datos (figura 49). Sin embargo, en caso hubiera surgido inconsistencias en alguna estación, 

esta se habría eliminado. 

 

Tabla 5: PP acumuladas 

AÑO 
PP acumuladas de Estaciones (mm) PP media 

acumulada 

(mm) MALVAS COTAPARACO CHAMANA HUARMEY 

1990 233.80 269.70 46.30 1.28 137.77 

1991 604.00 498.70 74.30 2.06 294.77 

1992 842.30 641.40 104.40 2.89 397.75 

1993 1394.00 1360.26 323.80 8.98 771.76 

1994 1912.80 1697.76 424.70 11.78 1011.76 

1995 2164.60 1976.56 484.70 13.44 1159.82 

1996 2558.40 2342.56 590.30 16.37 1376.91 

1997 3108.80 2740.56 714.90 19.82 1646.02 

1998 3971.30 3412.26 1054.60 29.24 2116.85 

1999 4636.00 3912.90 1274.40 35.33 2464.66 

2000 5203.10 4399.10 1402.94 38.03 2760.79 

2001 5762.20 4897.80 1547.68 39.63 3061.83 

2002 6279.64 5353.10 1651.58 40.63 3331.24 

2003 6604.14 5702.90 1730.89 51.83 3522.44 

2004 6947.94 5962.75 1783.59 53.30 3686.90 

2005 7226.71 6165.25 1810.89 55.00 3814.46 

2006 7737.11 6572.72 1885.39 55.20 4062.61 

2007 8140.01 6919.82 1975.60 58.20 4273.41 

2008 8702.81 7330.42 2094.98 59.10 4546.83 

2009 9316.91 7853.52 2242.89 63.20 4869.13 

2010 9650.41 8258.89 2358.66 65.40 5083.34 
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Figura 49: Curva de doble masa 

 

Una vez que se comprobó la confiabilidad de los datos, se ordenaron las estaciones con la 

información de sus coordenadas, altura y precipitación anual media (Tabla 6). Después, con 

el fin de obtener más datos de precipitaciones en la zona de estudio, se crearon nuevos puntos 

en la cuenca. Para calcular el valor en estos nuevos puntos, se hizo una comparación entre 

altura y precipitación de las 4 estaciones (figura 50), la cual generó un R=0.9, que significó 

la validez de esta relación y permitió que se use la ecuación generada para hallar las nuevas 

precipitaciones, utilizando el valor de las alturas con que se cuentan. 

 

Tabla 6: Datos completos de las estaciones 

ESTACIONES LATITUD LONGITUD 
ALTURA 

(m.s.n.m.) 

PP media 

(mm) 

MALVAS -9.93° -77.65° 3500 459.54 

COTAPARACO -9.98° -77.58° 3008 393.28 

CHAMANA -10.25° -77.57° 2000 112.32 

HUARMEY -10.08° -78.17° 20 3.11 
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Figura 50: Relación Altura vs. PP media 

 

Se agregaron 25 puntos adicionales a los 4 ya existentes. Se hallaron sus alturas gracias al 

DEM elaborado previamente y ya con estos datos, se calcularon los valores de 

precipitaciones con la ecuación señalada en la Figura 50. El resultado se puede observar en 

el Tabla 7. 

 

Tabla 7: Puntos con los nuevos datos de precipitaciones 

Id X (m) Y (m) 
Altura 

(m.s.n.m.) 

PP media 

(mm) 

1 209414.79 8900798.61 3500.00 459.54 

2 216809.61 8895323.08 3008.00 393.28 

3 218797.31 8865824.94 2000.00 112.32 

4 152832.73 8883692.76 20.00 3.11 

5 167413.80 8880318.98 464.29 19.01 

6 171394.66 8890314.06 380.42 7.80 

7 175517.62 8884819.24 465.37 19.16 

8 172351.52 8905813.11 600.00 37.16 

9 176636.24 8899845.02 463.22 18.87 
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10 179982.53 8893552.42 450.98 17.24 

11 184572.61 8888219.06 909.83 78.58 

12 185474.93 8910669.73 2162.08 246.01 

13 188836.05 8902480.13 1026.27 94.15 

14 192182.69 8895870.90 1024.95 93.97 

15 194407.91 8892096.84 1700.00 184.23 

16 196606.05 8910289.25 2385.64 275.90 

17 201237.23 8899739.37 1518.96 160.02 

18 204605.76 8890127.39 2350.00 271.13 

19 201094.25 8917279.25 3444.25 417.44 

20 205559.96 8907675.76 3600.00 438.26 

21 205575.61 8925374.29 4107.87 506.16 

22 212602.22 8908837.79 4408.58 546.37 

23 218130.05 8903192.42 4550.00 565.27 

24 223657.39 8897388.63 4292.46 530.84 

25 214024.99 8927494.26 3835.68 469.77 

26 220242.47 8913795.03 4313.91 533.71 

27 225013.32 8904508.96 4295.76 531.28 

28 217215.54 8920250.24 4202.29 518.79 

29 214476.02 8889732.90 3326.91 401.75 

 

Finalmente, se hizo una interpolación de estos valores con la herramienta Spline, ubicada en 

la dirección ArcToolbox > Spatial Analyst Tools > Interpolation > Spline, y en cuya 

ventana se agregó el archivo shape de los puntos; se seleccionó en el campo que contenía 

los valores Z, el campo de PP media anual; se indicó la ruta de salida del archivo ráster y el 

tamaño de celda, que en este estudio fue de 30 m. (figura 51). 
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Figura 51: Ventana de Spline 

 

3.3.3. Fase de Campo 

 

En la primera visita que se realizó, se efectuó la reunión con el director de la Agencia Agraria 

de Huarmey, el Ing. Efraín Motta, a quien se le explicó el tema que trataba la tesis, así como 

los objetivos que esta buscaba. Como resultado de esta primera asamblea, se trazó un primer 

recorrido por la cuenca Huarmey, para la identificación las características de las diferentes 

zonas que la conforman. Una vez que se estableció la ruta de viaje, se procedió con el 

reconocimiento de la cuenca, la zona urbana, las zonas agrícolas que la conforman, las áreas 

montañosas, etc. 

 

La segunda visita que se realizó a la cuenca Huarmey, fue luego de obtener los primeros 

modelos para realizar la validación de campo. Así mismo, se llevó a cabo la toma de muestras 

de los tipos de suelos que conformaban la cuenca, con el fin de obtener información de la 

textura y el porcentaje de materia orgánica; además que se realizaron pruebas de infiltración. 

Para esta segunda fase, también se contó con la ayuda del Ing. Motta, ya que se requirió del 

permiso de algunos propietarios, para poder ingresar a sus territorios y obtener dichas 

muestras. 
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3.3.4. 2da fase de Geoprocesamiento 

 

a. Construcción de Base de Datos Geoespaciales 

 

La base de datos del presente estudio fue diseñada gracias al software Enterprise Architect, 

con el cual se realizó el esquema lógico de las variables a utilizar para los modelos de 

inundaciones, vulnerabilidad y USLE, para luego construir la geodatabase en el software 

ArcGIS. 

 

 

Figura 52: Esquema lógico de la base de datos de los modelos de inundaciones 
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Figura 53: Esquema lógico de la base de datos del modelo de vulnerabilidad 

 

 

Figura 54: Esquema lógico de la base de datos del modelo USLE 
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b. Elaboración de los modelos geoespaciales de Inundaciones 

 

De acuerdo con Wahid et al. (2016), para la generación del Mapa de Índice Potencial de 

Inundaciones Extraordinarias, solo se requieren de cuatro capas temáticas, las cuales son: 

factor forma, pendiente, cobertura y capacidad de infiltración, y no se toma en cuenta la capa 

de precipitaciones, ya que el estudio se basa en precipitaciones inusuales, que no se registran 

normalmente en la zona.  

 

Sin embargo, en la presente tesis se realizó un primer modelo, adaptado del estudio de Wahid 

et al., tomando en cuenta las cuatro capas mencionadas previamente y un segundo modelo, 

tomando en cuenta los datos de precipitaciones, esto con el fin de realizar una mejor 

identificación de las zonas vulnerables. 

 

• Mapa de Inundaciones Extraordinarias 

 

Para este modelo, no se tomó en cuenta la capa de precipitaciones y solo se usaron las 

variables de cobertura, capacidad de infiltración, factor forma; y el ráster de pendiente.  

 

Entonces, para iniciar con este proceso se convirtieron las tres capas vectoriales al formato 

ráster ya que, para hallar el mapa de inundaciones extraordinarias, se requirió de la 

herramienta Superposición Ponderada (Weighted Overlay) de ArcGIS, la cual ejecuta esta 

función solo con archivos en formato ráster.  

 

Por lo tanto, se procedió con la conversión de las capas vectoriales de cobertura, capacidad 

de infiltración y factor forma, a un formato ráster. Para ello se usó la herramienta Polígono 

a Ráster (Polygon to Raster), ubicado en la dirección ArcToolbox > Conversion Tools > 

To Raster > Polygon to Raster, donde se ingresaron los archivos vectoriales, se seleccionó 

el campo que se utilizó para asignar los valores del ráster, se añadieron las rutas de salida y 

se indicó el tamaño de celda, que en este caso para que la superposición funcione de forma 

correcta, todas las capas tuvieron un mismo tamaño de 30 m. (figura 55).  

 

Así mismo, para que se efectúe este mismo procedimiento en las tres capas, se utilizó la 

aplicación ModelBuilder, donde se ingresaron los datos requeridos, que se explicaron 
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previamente para la conversión a un formato ráster y finalmente se dio clic a la opción correr 

(Run). En la figura 56 se muestra el modelo para este procesamiento. 

 

 

Figura 55: Ventana de Polygon to Raster 

 

 

Figura 56: Uso de ModelBuilder para convertir un shape a ráster  
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Después, con la ayuda del software ArcGIS se reclasificaron estos valores según una escala 

de 1 a 10, de los cuales los valores que tenían menor impacto en la formación de 

inundaciones fueron los cercanos al uno, mientras que los que podían originar grandes 

escorrentías fueron los cercanos al 10 (Tabla 8).  

 

Tabla 8: Pesos y niveles 

Pesos  Nivel  

1 
Muy Bajo 

2 

3 
Bajo 

4 

5 
Moderado 

6 

7 
Alto 

8 

9 
Muy Alto 

10 

 

Gracias a esta tabla, se procedió con la reclasificación de las cuatro capas en formato ráster, 

que cabe recalcar contaban con un mismo tamaño de celda y se encontraban en el mismo 

sistema de coordenadas. Este proceso se realizó con la herramienta Reclasificar (Reclassify), 

ubicado en ArcToolbox > Spatial Analyst Tools > Reclass > Reclassify. Para este 

procesamiento se utilizó la aplicación ModelBuilder, como se muestra en la figura 57. 

 

En la tabla 9 se muestra las categorías de cada capa, así como los pesos y niveles otorgados 

a cada rango. En esta parte del procedimiento existe una variación con la metodología de 

Wahid et al., que se da en la clasificación de las pendientes. Para el desarrollo de esta tesis, 

a las pendientes más pronunciadas se les asignó un menor peso y a las pendientes leves uno 

mayor, ya que es en la zona llana donde las inundaciones se producen.  
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Tabla 9: Primera clasificación de los pesos y niveles de cada categoría   

Capa Categoría Pesos  Nivel  

Pendiente 

> 60% 1 
Muy Bajo 

40% - 60% 2 

35% - 40% 3 
Bajo 

30% - 35% 4 

25% - 30% 5 
Moderado 

20% - 25% 6 

15% - 20% 7 
Alto 

10% - 15% 8 

5% - 10% 9 
Muy Alto 

< 5% 10 

Factor Forma 

Muy Alargada 1 
Muy Bajo 

Alargada 2 

Ligeramente alargada 3 Bajo 

Ni alargada ni 

ensanchada 
5 Moderado 

Ligeramente ensanchada 7 
Alto 

Ensanchada 8 

Muy ensanchada 9 
Muy Alto 

Rodeando el desagüe 10 

Capacidad de 

infiltración 

A (alta infiltración) 1 Muy Bajo 

B (media infiltración) 5 Moderado 

C (baja infiltración) 10 Muy Alto 

Cobertura 

Matorrales 3 Bajo 

Agrícola 5 Moderado 

Montañas 7 Alto 

Llanura arenosa 9 

Muy Alto 

Urbana 9 

Laguna 10 

Rio 10 

Suelo desnudo 10 
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Figura 57: Uso de ModelBuilder para reclasificar las capas  

 

Una vez que se obtuvieron los ráster con los valores definidos, se procedió con la 

superposición ponderada de capas, para lo cual se tomó en cuenta la Table de Ponderación 

de Valores (Tabla 10), y junto a la información de la Tabla 9, se ejecutó la aplicación 

ModelBuilder, donde se creó el flujo de trabajo del modelo del Mapa de Inundaciones 

Extraordinarias. En el entorno del ModelBuilder se agregaron los ráster y la función 

Weighted Overlay, cuya ruta fue ArcToolbox > Spatial Analyst Tools > Overlay > 

Weighted Overlay para realizar el modelamiento geoespacial de las variables (figura 58). 
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Tabla 10: Primera Ponderación de Valores 

Variable 
Grado de 

Participación 

Pendiente 50 

Factor Forma 10 

Capacidad de infiltración 30 

Cobertura 10 

 

 

Figura 58: Uso de ModelBuilder para la integración de variables 

 

• Mapa de Inundaciones, considerando PP 

 

Este segundo modelo se construyó utilizando el mismo procedimiento que el anterior, con 

la única diferencia que a la Tabla 9, de pesos y niveles de cada capa, se agregó la variable 

de precipitaciones, como se muestra en la Tabla 11. Así mismo, para la ponderación de los 

valores de las capas, se utilizó la Tabla 12, donde se considera el grado de la capa de 

precipitaciones. 
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Tabla 11: Segunda clasificación de los pesos y niveles de cada categoría   

Capa Categoría Pesos Nivel  

Pendiente 

> 60% 1 
Muy Bajo 

40% - 60% 2 

35% - 40% 3 
Bajo 

30% - 35% 4 

25% - 30% 5 
Moderado 

20% - 25% 6 

15% - 20% 7 
Alto 

10% - 15% 8 

5% - 10% 9 
Muy Alto 

< 5% 10 

Factor Forma 

Muy Alargada 1 
Muy Bajo 

Alargada 2 

Ligeramente alargada 3 Bajo 

Ni alargada ni ensanchada 5 Moderado 

Ligeramente ensanchada 7 
Alto 

Ensanchada 8 

Muy ensanchada 9 
Muy Alto 

Rodeando el desagüe 10 

Capacidad de 

infiltración 

A (alta infiltración) 1 Muy Bajo 

B (media infiltración) 5 Moderado 

C (baja infiltración) 10 Muy Alto 

Cobertura 

Matorrales 3 Bajo 

Agrícola 5 Moderado 

Montañas 7 Alto 

Llanura arenosa 9 

Muy Alto 

Urbana 9 

Laguna 10 

Rio 10 

Suelo desnudo 10 

Precipitación 

0 – 150 mm 1 Muy Bajo 

150 – 300 mm 4 Bajo 

300 – 450 mm 7 Alto 

450 - 600 mm 10 Muy Alto 
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Tabla 12: Segunda Ponderación de Valores 

Variable 
Grado de 

Participación 

Pendiente 50 

Factor Forma 10 

Capacidad de infiltración 20 

Cobertura 10 

Precipitación 10 

 

c. Modelo Geoespacial de Vulnerabilidad Física 

 

Así mismo, se elaboró un modelo para identificar las zonas vulnerables a los procesos 

erosivos debido a las precipitaciones. Por lo cual, se requirieron de las variables de cobertura, 

geología, geomorfología, pendientes y precipitaciones, para que sean intersecadas y obtener 

nuevos polígonos, a los que se les aplicaron una ecuación para obtener su nivel de 

vulnerabilidad. 

 

Se inició este procedimiento con la reclasificación de los archivos ráster de pendientes y 

precipitaciones de acuerdo a las categorías presentadas en la Tabla 13, para después 

convertirlos a capas vectoriales con la herramienta Raster to Polygon (Figura 59).  

 

 

Figura 59: Conversión de los ráster a capas vectoriales en ModelBuilder 
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Una vez que se contaron con los cinco archivos en formato shape, se utilizó la función 

dissolve para sintetizar los datos. Luego con las cinco capas resultantes listas, en cada una 

de ellas se agregó un campo nuevo en la Tabla de Atributos con los pesos correspondientes 

según la Tabla 13 y seguidamente se procedió con la intersección de las capas con la 

herramienta Intersect en el entorno de ModelBuilder (Figura 60).  

 

Tabla 13: Tercera clasificación de los pesos y niveles de cada categoría   

Capa Categoría Pesos  Nivel 

Pendiente 

< 5% 1 
Estable 

5% - 10% 2 

10% - 15% 3 
Bajo 

15% - 20% 4 

20% - 25% 5 
Moderado 

25% - 30% 6 

30% - 35% 7 
Alto 

35% - 40% 8 

40% - 60% 9 
Muy Alto 

> 60% 10 

Cobertura 

Matorrales 3 Bajo 

Agrícola 5 Moderado 

Montañas 7 Alto 

Llanura arenosa 9 

Muy Alto 

Suelo desnudo 10 

Laguna 10 

Rio 10 

Urbana 10 

Geología 

Depósito aluvial 1 
Estable 

Grupo Calipuy 2 

Formación La Zorra 3 Bajo 

Formación Lupín 5 
Moderado 

Formación Chimú 5 

Batolito de la Costa 7 
Alto 

Formación Junco 7 

Formación Santa, Carhuaz 10 Muy Alto 
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Geomorfología 

Mantos de arena  1 Muy Bajo 

Terraza aluvial 3 Bajo 

Colinas y lomadas 6 Moderado 

Montaña con pendientes 

suaves a moderadas 
8 Alto 

Montaña con pendientes 

moderadas a fuertes 
10 Muy Alto 

Precipitación 

0 – 150 mm 1 Estable 

150 – 300 mm 4 Bajo 

300 – 450 mm 7 Alto 

450 - 600 mm 10 Muy Alto 

 

 

 

Figura 60: Intersección de las cinco capas en ModelBuilder 
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Finalmente, en el modelo obtenido se agregó un nuevo campo donde se ingresó la ecuación 

para hallar la vulnerabilidad de cada polígono, con la opción Field Calculator (Figura 61), 

y con los valores obtenidos se hallaron las regiones con los niveles de vulnerabilidad estable, 

bajo, moderado, alto y muy alto.  

 

 

Figura 61: Cálculo de la Vulnerabilidad de la cuenca Huarmey
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d. Modelo Geoespacial para la identificación y cuantificación de la erosión del 

suelo con el método USLE 

 

La elaboración del mapa de erosión del suelo, se realizó de acuerdo a la fórmula de la USLE 

propuesta por Wischmeier y Smith en 1978. 

 

𝐴 = 𝑅 × 𝐾 × 𝐿 × 𝑆 × 𝐶 × 𝑃 

 

Donde las variables son: 

 

A: Cantidad de pérdida de suelo en una unidad de superficie (t/ha.año) 

R: Factor de precipitación y escorrentía (MJ.mm/ha.h.año) 

K: Factor de susceptibilidad del suelo a erosión (t.ha.h/ha.MJ.mm) 

L: Factor de longitud de la pendiente 

S: Factor de inclinación de la pendiente 

C: Factor de la cobertura vegetal 

P: Factor de prácticas de conservación 

 

• Factor de Precipitación (R) 

 

Para la elaboración de la capa del Factor R, se utilizó el archivo ráster del mapa de 

precipitaciones medias anuales, elaborado previamente, a la cual se aplicó la ecuación de 

Roose. 

 

𝑅 = 1.73 × 0.5 × 𝑃 

 

Donde: 

R = Factor de erosividad de la lluvia (MJ.mm/ha.h.año) 

P = Precipitación media anual (mm) 

 

Para obtener el factor de erosividad de precipitación se utilizó la aplicación ModelBuilder, 

donde se ingresó la herramienta de calculadora ráster (Raster Calculator) de ArcGIS, cuya 

dirección es ArcToolbox > Spatial Analyst Tools > Map Algebra > Raster Calculator, 
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para aplicar la ecuación de Roose (figura 62). Es importante mencionar que este ráster cuenta 

con un tamaño de celda de 30 m. 

 

 

Figura 62: Uso de la calculadora ráster para aplicar la ecuación de Roose 

 

 

Figura 63: Uso de ModelBuilder para calcular el Factor R  
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• Factor de Susceptibilidad a erosión del Suelo (K) 

 

El Factor K se halló, mediante las fórmulas de Sharpley y Williams (1990). 

 

𝐾𝑈𝑆𝐿𝐸 = 𝑓𝑐𝑠𝑎𝑛𝑑 × 𝑓𝑐𝑙−𝑠𝑖 × 𝑓𝑜𝑟𝑔𝑐 × 𝑓ℎ𝑖𝑠𝑎𝑛𝑑 

𝑓𝑐𝑠𝑎𝑛𝑑 = (0.2 + 0.3 × 𝑒𝑥𝑝−0.256×𝑚𝑠(1−
𝑚𝑠𝑖𝑙𝑡
100

)) 

𝑓𝑐𝑙−𝑠𝑖 = (
𝑚𝑠𝑖𝑙𝑡

𝑚𝑐 + 𝑚𝑠𝑖𝑙𝑡

)
0.3

 

𝑓𝑜𝑟𝑔𝑐 = (1 −
0.25 × 𝑜𝑟𝑔𝐶

𝑜𝑟𝑔𝐶 + 𝑒𝑥𝑝[3.72 − 2.95 × 𝑜𝑟𝑔𝐶]
) 

𝑓ℎ𝑖𝑠𝑎𝑛𝑑 = (1 −
0.7 × (1 −

𝑚𝑠

100
)

(1 −
𝑚𝑠

100
) + 𝑒𝑥𝑝[−5.51+22.9×(1−

𝑚𝑠
100

)]
) 

 

Siendo: 

KUSLE: Factor de Susceptibilidad a erosión del Suelo  

ms: Porcentaje de arena 

msilt: Porcentaje de limo 

mc: Porcentaje de arcilla 

orgC: Porcentaje de materia orgánica 

 

Para la elaboración del mapa del Factor K, se utilizó la capa de Geología, elaborada 

previamente y se recolectaron muestras de suelo de diferentes puntos de la cuenca para 

conocer las características que poseían cada unidad.  

 

Se llevaron a cabo visitas de campo a las zonas clasificadas y se tomaron muestras de suelo 

a 45 cm. de cada una de ellas, para esta actividad se contó con la ayuda de los ingenieros de 

la Agencia Agraria de Huarmey, como se muestra en las siguientes fotografías.  
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Figura 64: Toma de muestras en la unidad Batolito de la Costa 

 

 

Figura 65: Toma de muestras en la unidad Depósito Aluvial 
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Figura 66: Toma de muestras en la unidad Formación Chimú 

 

 

Figura 67: Toma de muestras en la unidad Formación Junco 
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Figura 68: Toma de muestras en la unidad Formación La Zorra 

 

Figura 69: Toma de muestras en la unidad Formación Lupín 
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Figura 70: Toma de muestras en la unidad Formación Santa, Carhuaz 

 

Figura 71: Toma de muestras en el Grupo Calipuy 
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Una vez recopiladas las muestras, estas fueron enviadas al Laboratorio de Suelos de la 

Universidad Nacional Agraria La Molina (UNALM), para el cálculo de los porcentajes de 

arena, arcilla, limo y materia orgánica (Anexo 11). 

 

Los resultados de los porcentajes de arena, arcilla, limo y materia orgánica se ingresaron a 

una hoja Excel, y se realizó el cálculo del Factor K. La tabla de valores de “K” para cada 

unidad geológica de la cuenca se muestra en la Tabla 14. 

 

Luego, se ingresaron los valores de “K” a la Tabla de Atributos del archivo en shape de las 

unidades geológicas de la zona de estudio. 

 

Tabla 14: Valores del Factor K 

Unidades de Suelo 
Arena 

(%) 

Limo 

(%) 

Arcilla 

(%) 

Materia 

Orgánica 

(%) 

K 

Batolito de la Costa 57 26 17 1.32 0.145 

Depósito Aluvial 93 2 5 0.02 0.063 

Formación Chimú 66 16 18 4.97 0.117 

Formación Junco 47 34 19 0.54 0.172 

Formación La Zorra 79 12 9 0.15 0.134 

Formación Lupín 79 12 9 0.15 0.134 

Formación Santa, Carhuaz 74 16 10 3.45 0.117 

Grupo Calipuy 44 28 28 1.75 0.127 

 

Después, se utilizó la herramienta Polygon to Raster en el espacio de ModelBuilder, donde 

se especificaron que los valores de campo (Value Field) para obtener el ráster son los del 

Factor K, hallados en la Tabla 14, así mismo se ingresó la ruta de salida y el tamaño de celda 

de 30 m. (utilizado en todos los ráster de esta tesis). 

 

 

Figura 72: Uso de ModelBuilder para hallar el Factor K 
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• Factor Topográfico (LS) 

 

Para hallar este factor, se utilizó la capa de pendientes en porcentajes y se reclasificaron los 

valores, con la función Reclassify, de acuerdo a los rangos de la tabla elaborada por la 

Facultad de Hidráulica e Hidrología de la Escuela Técnica Superior de Ingenieros de Montes 

de Madrid (Figura 73). Luego, el ráster reclasificado fue convertido a un archivo shape con 

la herramienta Raster to Polygon y después se utilizó la función Dissolve para sintetizar los 

datos.  

 

 

Figura 73: Reclasificación de las pendientes 

 

 

 



96 

 

En la tabla de atributos de la capa resultante, se añadió un nuevo campo donde se ingresaron 

los valores de LS de acuerdo al grupo de pendientes (Figura 74). Por último, se convirtió la 

capa vectorial a ráster nuevamente, con un tamaño de celda de 30 m., pero a diferencia del 

primer ráster con los valores de las pendientes, en este último se tomaron en cuenta los 

valores de LS en Value Field. 

 

 

Figura 74: Adición del Campo LS en la Tabla de Atributos 

 

• Factor de Cobertura Vegetal (C) 

 

Para hallar el Factor C se requirió del uso del Mapa de Cobertura de la cuenca, generado en 

la sección de Construcción de Base de Datos Geoespaciales, para reclasificar las clases 

originales del cero a uno. Estos nuevos valores representaron el nivel en que cada tipo de 

cobertura afecta en la tasa de erosión. Para las áreas con una mayor cobertura vegetal, se les 

asignaron valores de C cercanos a cero, y para las zonas con superficie desprotegida, valores 

cercanos a uno. Los valores que fueron asignados a cada clase se muestran en la Tabla 15. 
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Tabla 15: Valores del Factor C 

Clases Factor C 

Agrícola 0.3 

Laguna 1 

Llanura arenosa 1 

Matorrales 0.2 

Montañas  0.7 

Rio 1 

Suelo desnudo 1 

Urbana 0.8 

 

 

Estos valores se agregaron en la Tabla de Atributos del archivo en formato shape de la 

cobertura de la cuenca y luego, se procedió con la conversión a formato ráster (30 m.) de 

este archivo, tomando en cuenta los valores del Factor C, en la aplicación ModelBuilder 

(Figura 75). 

 

 

Figura 75: Uso de ModelBuilder para hallar el Factor C 

 

• Factor de Prácticas de Conservación (P) 

 

Este factor representa la actividad de protección contra la erosión debida a fuertes 

escorrentías, sin embargo, debido a que estas prácticas no se presentan en el área de estudio, 

se otorgó el valor de uno en la ecuación. 
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• Identificación y cuantificación de la erosión hídrica (USLE) 

 

Finalmente, una vez obtenido los factores R, K, LS y C, que requería la ecuación USLE, con 

un mismo tamaño de celda de 30 m., se procedió con el modelamiento geoespacial para la 

integración de variables, mediante la multiplicación de estos parámetros con la función 

Raster Calculator (figura 76). 

 

 

Figura 76: Modelamiento geoespacial para hallar la ecuación USLE 
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IV. RESULTADOS Y DISCUSIÓN 

 

4.1. 1ra FASE DE GEOPROCESAMIENTO 

 

Como resultado del primer geoprocesamiento de los datos de la cuenca se obtuvo la siguiente 

información temática. 

 

4.1.1. Cobertura Vegetal 

 

El resultado de la clasificación no supervisada se mostró en la Figura 77, sin embargo, este 

primer mapa no cuenta con una división clara de los siete tipos de cobertura. Luego, se 

efectuó la clasificación supervisada, que contó con 11 clases de cobertura (Figura 78), a la 

cual se le hicieron correcciones utilizando el programa Google Earth Pro y la información 

obtenida de las visitas de campo. 

 

Como resultado de la clasificación final de la cuenca Huarmey, se obtuvieron ocho tipos de 

cobertura. La clase que abarcó una mayor área, fue la de Matorrales, cuya superficie fue de 

1410.25 km2, lo que equivalió al 62.82 por ciento del área total y se ubicó desde la parte 

media a alta de la cuenca, en la zona andina. En la zona media a baja de la cuenca se 

encontraron las Montañas, cuya área fue la segunda más grande, con 476.22 km2, que 

representó el 21.21 por ciento de la superficie de la cuenca. Por otro lado, en la cuenca baja 

se halló la clase de Llanura Arenosa, con 119.18 km2, que comprendió el 5.31 por ciento del 

área de estudio. Las áreas agrícolas se encontraron a lo largo de toda la cuenca y contaron 

con una superficie de 128.08 km2, lo que significó el 5.71 por ciento del área total. Las zonas 

de Suelo Desnudo tuvieron un área de 101.53 km2, lo que representó el 4.52 por ciento. 

Finalmente, el resto de tipos de cobertura abarcaron menos del uno por ciento del área total. 

 

 



100 

 

Tabla 16: Resultados del mapa de cobertura  

Clases Área (km2) Área (%) 

Agrícola 128.08 5.71 

Laguna 3.21 0.14 

Llanura arenosa 119.18 5.31 

Matorrales 1410.25 62.82 

Montañas  476.22 21.21 

Río 2.14 0.10 

Suelo desnudo 101.53 4.52 

Urbana 4.29 0.19 
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Figura 77: Clasificación no supervisada de la cuenca Huarmey 

 

 

Figura 78 Clasificación supervisada de la cuenca Huarmey 
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Figura 79: Mapa de cobertura de la cuenca Huarmey 
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4.1.2. Pendiente 

 

Se obtuvo un mapa de pendientes en porcentajes, el cual mostró que el rango de 40 a 60 por 

ciento, representaron a los terrenos escarpados, y son los que poseen mayor área en la cuenca, 

contando con 520.28 km2, lo que significó un 25.40 por ciento del área total. La segunda 

zona con mayor área, fue la que presentaba pendientes de 20 a 40 por ciento, con un área de 

565.99 km2, equivalente al 25.21 por ciento del total de la superficie. Las pendientes mayores 

al 60 por ciento, fue la tercera región más grande, cuyo terreno era extremadamente 

empinado y abarcó una superficie de 476.96 km2, que representó el 21.25 por ciento de la 

zona de estudio. El rango de pendientes menores a 5 por ciento presentó un área de 360.05 

km2, abarcando el 16.04 por ciento del área total. Por último, los rangos restantes de 5 a 10 

por ciento y de 10 a 20 por ciento, ocuparon áreas menores al 10 por ciento de la cuenca. 

 

Tabla 17: Resultados del mapa de pendientes en porcentaje 

Rangos Área (km2) Área (%) 

< 5% 360.05 16.04 

5% - 10% 77.63 3.46 

10% - 20% 193.99 8.64 

20% - 40% 565.99 25.21 

40% - 60% 570.28 25.40 

> 60% 476.96 21.25 
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Figura 80: Mapa de pendientes en porcentaje de la cuenca Huarmey 
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4.1.3. Capacidad de Infiltración 

 

Esta capa se realizó gracias al Mapa de Hidrogeología Nacional del INGEMMET, donde 

resultaron tres tipos de suelo dentro de la cuenca Huarmey, que se muestra en la figura 81. 

En la tabla 18 se puede observar, que el suelo tipo A, cuya capacidad de infiltración es alta, 

abarcó un área de 614.53 km2, correspondiente al 27.37 por ciento de la superficie total de 

la cuenca, y que se halla en la parte baja de la unidad hidrográfica. Los suelos de tipo B, 

cuentan con un nivel medio de permeabilidad, y fue la zona que contó con la mayor área, 

1286.96 km2, lo que significó el 57.33 por ciento y se puede observar principalmente en la 

parte alta de la cuenca. Por último, los suelos de tipo C, presentaron una capacidad de 

infiltración baja y presentó un área de 343.41 km2, que representó el 15.30 por ciento del 

total y se encontraron en la parte media de la cuenca, a los lados del valle. 

 

 

Tabla 18: Resultados del mapa de capacidad de infiltración 

Capacidad de 

infiltración 

Tipo de 

suelo 

Área 

(km2) 
Área (%) 

Alta A 614.53 27.37 

Media B 1286.96 57.33 

Baja C 343.41 15.30 
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Figura 81: Mapa de Capacidad de Infiltración de la cuenca Huarmey 



107 

 

4.1.4. Geología 

 

Ochos unidades geológicas conformaron la cuenca Huarmey, siendo el Grupo Calipuy, 

localizado en la parte más alta de la cuenca y compuesto principalmente por lavas andesíticas 

y piroclastos, el que abarcó la mayor área, con 748.39 km2 que representó el 33.34 por ciento 

del total. La segunda unidad más grande fue la Formación Junco, característico por la 

presencia de lavas almohadilladas, con un área de 484.89 km2, que significó el 21.60 por 

ciento de la superficie de la cuenca. La tercera unidad que predominó fue el Batolito de la 

Costa, constituido por colinas y montañas de monzogranito en la zona media de la cuenca, 

cuya superficie fue de 467.45 km2, equivalente al 20.82 por ciento. Los depósitos aluviales, 

que se encontraron a lo largo del valle y en las zonas de suelo desnudo, ocuparon 248.56 

km2, comprendiendo el 11.07 por ciento del área total, siendo la cuarta unidad más 

sobresaliente. Las cuatro formaciones geológicas restantes solo ocuparon menos del 6 por 

ciento del área de la cuenca cada una. 

 

Tabla 19: Resultados del mapa de geología 

Unidades 

Geológicas 
Área (km2) Área (%) 

Batolito de la 

Costa 
467.45 20.82 

Depósito aluvial 248.56 11.07 

Formación Chimú 32.03 1.43 

Formación Junco 484.89 21.60 

Formación La 

Zorra 
98.85 4.40 

Formación Lupín 45.43 2.02 

Formación Santa, 

Carhuaz 
119.41 5.32 

Grupo Calipuy 748.39 33.34 
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Figura 82: Mapa de Geología de la cuenca Huarmey 
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4.1.5. Geomorfología 

 

Se identificaron cinco unidades geomorfológicas en la zona de estudio, de las cuales la que 

predominó fueron las Montañas con pendientes moderadas a fuertes, ubicada en la zona 

media a alta de la cuenca y que abarcó un área de 1407.73 km2, significando el 62.71 por 

ciento de la superficie total. Las Colinas y lomadas, fue la segunda unidad más grande, que 

se encontró principalmente en la zona media de la cuenca, con una superficie de 322.18 km2, 

que representó el 14.35 por ciento del total. Así mismo, las Montaña con pendientes suaves 

a moderadas contaron con un área de 198.27 km2, equivalente al 8.86 por ciento. Los mantos 

de arena ubicados en la región costera tuvieron un área de 170.78 km2, ocupando el 7.61 por 

ciento del área total. Finalmente, la Terraza Aluvial localizada en la zona de los valles y 

quebradas, presentaron una superficie de 146.04 km2, que significó el 6.50 por ciento del 

total de la cuenca. 

 

Tabla 20: Resultados del mapa de geomorfología 

Unidades 

Geomorfológicas 
Área (km2) Área (%) 

Colinas y lomadas 322.18 14.35 

Mantos de arena 170.78 7.61 

Montañas con pendientes 

suaves a moderadas 
198.27 8.83 

Montañas con pendientes 

moderadas a fuertes 
1407.73 62.71 

Terraza aluvial 146.04 6.50 
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Figura 83: Mapa de Geomorfología de la cuenca Huarmey 
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4.1.6. Factor Forma 

 

Se llevó a cabo la clasificación de los valores del factor forma de las cuencas, basado en la 

Tabla 3, de acuerdo a Pérez, citado por Córdova (2016). Por lo tanto, se obtuvo ocho tipos 

de formas en toda la cuenca, como se muestra en la Tabla 21. La forma que más predominó 

entre las cuencas, fue la del tipo Ligeramente Ensanchada, la cual ocupó un área de 450.07 

km2, siendo éste el 20.05 por ciento del área total. Las cuencas con forma Muy Ensanchada, 

tuvieron un área de 412.01 km2, lo que significó el 18.35 por ciento. El tercer tipo de cuencas 

con mayor área, fueron las de la forma Ligeramente Alargada, cuya superficie fue de 383.63 

km2, equivalente al 17.09 por ciento. Las cuencas de forma Alargada, contaron con 309.05 

km2 de área, que significó el 13.77 por ciento. Las cuencas clasificadas como Ni Alargadas 

Ni Ensanchadas, tuvieron una superficie de 247.34 km2, ocupando el 11.02 por ciento del 

total de la cuenca. Los tres tipos de forma restante, Muy Alargada, Ensanchada y Rodeando 

el desagüe, alcanzaron áreas menores al 10 por ciento del total cada una, la primera con 

189.03 km2 (8.42 por ciento), la segunda con 167.54 km2 (7.46 por ciento) y la última con 

86.33 km2 (3.85 por ciento). 

 

 

Tabla 21: Resultados del mapa de factor forma 

Forma Área (km2) Área (%) 

Muy Alargada 189.03 8.42 

Alargada 309.05 13.77 

Ligeramente Alargada 383.63 17.09 

Ni Alargada Ni 

Ensanchada 
247.34 11.02 

Ligeramente Ensanchada 450.07 20.05 

Ensanchada 167.54 7.46 

Muy Ensanchada 412.01 18.35 

Rodeando el desagüe 86.33 3.85 
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Figura 84: Mapa de factor forma de la cuenca Huarmey 
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4.1.7. Precipitación 

 

Las precipitaciones que se obtuvieron en este mapa fueron obtenidas como un promedio 

anual (mm/año). Como se muestra en figura 85, el 44.99 por ciento de la superficie de la 

cuenca, o 1009.98 km2, presenta lluvias entre el rango de 0 a 150 mm/año, las cuales se 

manifiestan en la zona media y baja de la cuenca. Las precipitaciones van aumentando, a 

medida que la altura aumenta también, es por ello que el siguiente rango de 150 a 300 

mm/año, se encuentra en la zona media de la cuenca, ocupando 268.48 km2, equivalente al 

11.96 por ciento del total. La parte media a alta de la unidad hidrográfica presenta un rango 

de precipitaciones del 300 a 450 mm/año, con una superficie de 306.32 km2, que significó 

el 13.64 por ciento. En la parte más alta de la cuenca, se ubicó el rango de 450 a 600 mm/año, 

siendo esta zona la segunda con mayor área, la cual fue de 600.21 km2, ocupando el 29.41 

por ciento del total de la cuenca. 

 

 

 

Tabla 22: Resultados del mapa de precipitaciones 

PP media anual 

(mm/año) 

Área 

(km2) 
Área (%) 

0 - 150 1009.98 44.99 

150 - 300 268.48 11.96 

300 - 450 306.32 13.64 

450 - 600 660.21 29.41 
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Figura 85: Mapa de precipitaciones de la cuenca Huarmey 
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4.2. 2da FASE DE GEOPROCESAMIENTO 

 

4.2.1. Mapa de Inundaciones Extraordinarias 

 

Luego de realizar la superposición ponderada de las capas de Cobertura, Pendiente, 

Capacidad de Infiltración y Factor Forma se obtuvo el Mapa de Inundaciones 

Extraordinarias (figura 86), donde se muestran los niveles de amenaza ante fuertes 

precipitaciones imprevistas. Los resultados indicaron que el área de la cuenca que presentó 

un nivel muy bajo de amenaza fue de 67.79 km2, el cual representó el 3.02 por ciento de la 

superficie total. La zona que contó con un nivel bajo de vulnerabilidad ante estas 

inundaciones, fue la que contó con la mayor área, la cual fue de 1025.28 km2, lo que significó 

el 45.67 por ciento de la cuenca. El sector de la cuenca con un moderado nivel de amenaza, 

contó con 804.22 km2 de área, abarcando el 35.82 por ciento del total, siendo esta zona la 

segunda más grande. La región de la cuenca con un alto nivel de vulnerabilidad ante este 

fenómeno, se ubicó principalmente en la zona del valle y en la parte baja cerca a la costa, y 

tuvo un área de 345.90 km2, comprendiendo el 15.41 por ciento. Por último, la zona con un 

nivel muy alto de amenaza presentó una superficie de 1.71 km2, representando solo el 0.08 

por ciento de la superficie. 

 

Así mismo, se puede observar que los puntos donde se registraron inundaciones en el año 

2017 por el fenómeno del Niño Costero, coinciden con la zona con un nivel alto y muy alto 

de susceptibilidad ante inundaciones extraordinarias. 

 

Tabla 23: Resultados del mapa de inundaciones extraordinarias 

Nivel Área (km2) Área (%) 

Muy Alto 1.71 0.08 

Alto 345.90 15.41 

Moderado 804.22 35.82 

Bajo 1025.28 45.67 

Muy Bajo 67.79 3.02 
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Figura 86: Mapa de inundaciones extraordinarias de la cuenca Huarmey 
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Figura 87: Mapa de inundaciones extraordinarias de la cuenca Huarmey y puntos donde se 

produjeron inundaciones durante el Niño Costero, según INGEMMET
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Figura 88: Primera vista a detalle del Mapa de inundaciones extraordinarias 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figura 89: Segunda vista a detalle del Mapa de inundaciones extraordinarias 
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4.2.2. Mapa de Inundaciones, considerando PP 

 

Este segundo modelo (figura 90), fue creado con la superposición de las capas de 

Precipitaciones, Cobertura, Pendiente, Capacidad de Infiltración y Factor Forma. Existen 

solo algunas variaciones en los niveles de vulnerabilidad ante inundaciones, respecto al 

primer modelo, a causa de la consideración de las precipitaciones en este mapa.  

 

La zona con un muy bajo nivel de amenaza presentó un área de 66.60 km2, equivalente al 

2.97 por ciento del total. Al igual que en el modelo anterior, el sector con mayor superficie 

fue el de nivel bajo, la cual contó con un área de 1092.77 km2, que representó el 46.68 por 

ciento de la cuenca. La región de la cuenca con un nivel moderado de amenaza ante 

inundaciones abarcó 721.39 km2, que significó el 32.13 por ciento. La superficie de la zona 

con un nivel alto de vulnerabilidad, fue de 360.53 km2, que representó el 16.06 por ciento 

de la cuenca, y tal como sucedió en el primer mapa de inundaciones, se localizó en el valle 

de la cuenca, y en la parte baja cerca a la costa, solo se observaron diferencias en la parte 

más alta de la cuenca, donde se incrementaron las regiones de alto nivel de vulnerabilidad 

debido a las fuertes precipitaciones que se producen anualmente. Las zonas con un nivel 

muy alto de amenaza, fueron las más pequeñas con un área de 3.62 km2, equivalente al 0.16 

por ciento del total. 

 

Tabla 24: Resultados del mapa de inundaciones, considerando PP 

Nivel Área (km2) Área (%) 

Muy Alto 3.62 0.16 

Alto 360.53 16.06 

Moderado 721.39 32.13 

Bajo 1092.77 48.68 

Muy Bajo 66.60 2.97 

 

 

 

 

 



120 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figura 90: Mapa de inundaciones de la cuenca Huarmey, considerando la capa de 

Precipitaciones 
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4.2.3. Mapa de Vulnerabilidad Física 

 

Este mapa se creó con el fin de hallar las zonas más vulnerables de la cuenca, para realizar 

una comparación con el modelo USLE y comprobar que las zonas más peligrosas 

concuerden. Los sectores con un nivel muy alto de vulnerabilidad se presentan en la zona 

más alta de la cuenca debido a las pendientes escarpadas de la región y la presencia de fuertes 

lluvias, abarcando un área de 79.39 km2, equivalente al 3.54 por ciento. Por otro lado, las 

zonas con un nivel alto de vulnerabilidad contó con una superficie de 886.89 km2, 

representando el 39.51 por ciento del área total, que abarca la misma zona que el rango de 

50 a 200 t/ha.año de pérdida de suelo en el modelo USLE, en la parte alta de la cuenca. Las 

zonas con nivel estable y bajo mantuvieron una relación con los menores rango de pérdida 

de suelo en el mapa USLE, del mismo modo sucede con el nivel moderado, y estos rangos 

se encuentra en la parte media y baja de la cuenca, donde las pendientes y precipitaciones 

son menores. 

 

Tabla 25: Resultados del mapa de vulnerabilidad física de la cuenca Huarmey 

 

Nivel de 

Vulnerabilidad 
Área (km2) Área (%) 

Muy Alto 79.39 3.54 

Alto 886.89 39.51 

Moderado 819.22 36.49 

Bajo 392.24 17.47 

Estable 67.16 2.99 
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Figura 91: Mapa de Vulnerabilidad Física de la cuenca Huarmey 
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Figura 92: Vista a detalle del Mapa de Vulnerabilidad Física 
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4.2.4. Modelo Geoespacial para la identificación y cuantificación de la erosión del 

suelo con el método USLE 

 

a. Factor de Precipitación (R) 

 

Los valores del Factor R, se clasificaron en cinco rangos con un intervalo de 100, los cuales 

al igual que en el mapa de precipitaciones, se observa que van aumentando a medida que la 

altura se incrementa. De este modo, la cuenca baja presentó el rango de 0 a 100, lo cual 

abarcó la mayor parte de la zona, con un área de 933.35 km2, que representó el 41.57 por 

ciento del total de la superficie. Por otro lado, la segunda zona con mayor área, fue la que se 

encontró en el rango de 400 a 501.22, la cual contó con un área de 621.24 km2, que significó 

el 27.67 por ciento de la cuenca, y se encontró en la parte alta de ésta. El tercer rango con 

mayor cobertura fue el de 300 a 400, que abarcó un área de 283.35 km2, equivalente al 12.62 

por ciento del total, y se encontró en la parte media y alta de la cuenca, donde la altura va 

disminuyendo. El rango de 100 a 200 tuvo un área de 231.85 km2, cubriendo un 10.33 por 

ciento de la cuenca. El rango con menor área fue el de 200 a 300, el cual abarcó una superficie 

de 175.21 km2, que representó el 7.80 por ciento del total del área. 

 

Tabla 26: Resultados del mapa de Factor R 

Factor R 

(MJ.mm/ha.h.año) 
Área (km2) Área (%) 

0 - 100 933.35 41.57 

100 - 200 231.85 10.33 

200 - 300 175.21 7.80 

300 - 400 283.35 12.62 

400 - 501.22 621.24 27.67 

 

 

 

 

 

 

 



125 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figura 93: Mapa del Factor R de la cuenca Huarmey 
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b. Factor de Susceptibilidad a erosión del Suelo (K) 

 

Los valores del Factor K se clasificaron en cinco rangos, como se muestra en la Tabla 27. El 

rango de 0.15 a 0.17, que fueron los mayores valores de K, abarcaron un área de 952.25 km2, 

equivalente al 42.42 por ciento y se encontró en la parte media y baja de la cuenca. El 

siguiente sector más grande, fue el de 0.13 a 0.14, cuya superficie fue de 748.37 km2, 

representando el 33.34 por ciento del área, localizándose en la zona más alta de la cuenca. 

La categoría con los valores de 0.06 a 0.12 contó con un área de 248.66 km2, y abarcó el 

11.08 por ciento de la cuenca, en la región de los valles y suelo desnudos. Así mismo, en la 

cuenca alta se encontró el rango de 0.12 a 0.13, que abarcó 151.48 km2, o el 6.75 por ciento 

de la cuenca. La región más pequeña fue la de la categoría de 0.14 a 0.15, con una superficie 

de 144.22 km2, equivalente al 6.42 por ciento del total. 

 

Tabla 27: Resultados del mapa de Factor K 

Factor K 

(t.ha.h/ha.MJ.mm) 
Área (km2) Área (%) 

0.06 - 0.12 248.66 11.08 

0.12 - 0.13 151.48 6.75 

0.13 - 0.14 748.37 33.34 

0.14 - 0.15 144.22 6.42 

0.15 - 0.17 952.25 42.42 
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Figura 94: Mapa del Factor K de la cuenca Huarmey 
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c. Factor Topográfico (LS) 

 

Los resultados obtenidos se presentaron en la Tabla 28. El rango que contó con una mayor 

área fue la de 14.60 a 25.20, ocupando 1076.24 km2, que representó el 47.94 por ciento del 

total del área y correspondieron a las altas pendientes de la zona de estudio. La segunda zona 

con mayor superficie, fue la que contó con los menores valores de LS, 0.30 a 1.50, con un 

área de 323.63 km2, abarcando 14.42 por ciento de la cuenca, localizado en la zona llana de 

la cuenca. El tercer rango con mayor área, fue la de 5.60 a 14.60, y contó con un área de 

305.90 km2, equivalente al 13.63 por ciento. Las pendientes con mayor inclinación dieron 

como resultado los valores de 25.2 a 28.5 y abarcaron un área de 277.37 km2, ocupando el 

12.36 por ciento del área total. Finalmente, el rango de 1.50 a 5.60 tuvo la menor área, con 

261.75 km2, equivalente al 11.66 por ciento. 

 

Tabla 28: Resultados del mapa de Factor LS 

Factor LS Área (km2) Área (%) 

0.3 - 1.5 323.63 14.42 

1.5 - 5.6 261.75 11.66 

5.6 - 14.6 305.90 13.63 

14.6 - 25.2 1076.24 47.94 

25.2 - 28.5 277.37 12.36 
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Figura 95: Mapa del Factor LS de la cuenca Huarmey 
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d. Factor de Cobertura Vegetal (C) 

 

Los resultados obtenidos en el mapa de cobertura (Figura 79), se le asignaron valores de C 

que estuvieron dentro del rango de cero a uno. Debido a que los Matorrales ocuparon la 

mayor parte de la cuenca, su valor correspondiente de C de 0.20 fue la más grande, abarcando 

un área de 1410.33 km2, que representó el 62.82 por ciento de la superficie total. Los valores 

de C de 0.7 a 0.8, que pertenecieron a la zona de Montañas de la parte media de la cuenca y 

la zona urbana, presentó un área de 480.52 km2, equivalente al 21.40 por ciento de la cuenca. 

Los valores de C de 0.9 a 1, se presentaron en la superficie sin cobertura vegetal, y contó 

una superficie de 225.90 km2, que significó el 10.06 por ciento, siendo la tercera zona más 

grande. Los demás valores contaron con superficies menores al 10 por ciento. 

 

Tabla 29: Resultados del mapa de Factor C 

Factor C Área (km2) Área (%) 

0 - 0.2 1410.33 62.82 

0.3 - 0.4 128.15 5.71 

0.5 - 0.6 0.00 0.00 

0.7 - 0.8 480.52 21.40 

0.9 - 1 225.90 10.06 
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Figura 96: Mapa del Factor C de la cuenca Huarmey 
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e. Mapa de Identificación y Cuantificación de la Erosión Hídrica (USLE) 

 

Como se muestra en la Figura 97, la zona donde se registraron las mayores pérdidas de suelo 

por erosión hídrica, de más de 200 t/ha.año, fue en la parte alta de la cuenca, debido a que 

en este sector se producen las mayores precipitaciones y existen pendientes altas, y contó 

con un área de 245.21 km2, equivalente al 10.92 por ciento del total de la cuenca. Por otro 

lado, la región con mayor área fue lo del rango de 50 a 200 t/ha.año, que abarcó un área de 

945.30 km2, abarcando el 42.11 por ciento del total, y presentó estos valores ya que es en 

esta zona donde se presentan precipitaciones significativas y cuenta con pendientes elevadas. 

La región con erosiones de 0 a 5 t/ha.año y de 5 a 10 t/ha.año fue la más segura y cuya 

superficie fue de 632.55 km2, representando el 28.18 por ciento. 

 

Tabla 30: Resultados del mapa de cuantificación de la erosión hídrica de la cuenca 

Huarmey 

Erosión Hídrica 

(t/ha.año) 

Área 

(km2) 

Área 

(%) 

0 - 5 437.35 19.48 

5 - 10 195.20 8.70 

10 - 50 421.84 18.79 

50 - 200 945.30 42.11 

> 200 245.21 10.92 
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Figura 97: Mapa de la Identificación y Cuantificación de la Erosión Hídrica de la cuenca 

Huarmey (USLE)
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Figura 98: Vista a detalle del Mapa de la Identificación y Cuantificación de la Erosión 

Hídrica de la cuenca Huarmey (USLE) 
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V. CONCLUSIONES 

 

• De acuerdo al objetivo general de la presente investigación se logró identificar las zonas 

vulnerables a inundaciones y procesos de erosión; así como cuantificar la cantidad la 

pérdida de suelo por erosión, mediante la aplicación del sistema de información 

geográfica (SIG), generando los modelos de inundaciones extraordinarias, inundaciones, 

vulnerabilidad física y USLE. 

 

• Se elaboró una Base de Datos Geoespacial con siete variables temáticas, las cuales 

fueron utilizadas para elaborar los modelos de inundaciones, inundaciones 

extraordinarias y vulnerabilidad física; así como para cuantificar la pérdida de suelos en 

la cuenca Huarmey. 

 

• El Mapa de Inundaciones Extraordinarias fue el primer modelo geoespacial que se 

elaboró, y cuyo principal factor que influyó en la formación de inundaciones fue la 

información temática de pendientes. Este modelo mostró cinco niveles de riesgo a 

inundaciones, muy bajo, bajo, moderado, alto y muy alto. Las zonas con nivel muy bajo 

se encuentran en la parte más alta de la cuenca, abarcando un área de 67.8 km2, donde 

las pendientes son escarpadas y existe mayor cobertura vegetal; las de nivel bajo se 

ubican en la zona de los matorrales en la parte media a alta de la cuenca, con un área de 

1025.3 km2; y la de nivel moderado contó con un área de 804.2 km2 principalmente en 

la zona de las colinas de la parte media de la cuenca. La zona que presentó un nivel alto 

de riesgo por inundaciones extraordinarias, se ubicó en la parte media y baja de la cuenca, 

donde se ubican los valles, el suelo desnudo y la llanura arenosa, ocupando un área de 

345.9 km2, esto debido principalmente a la presencia de pendientes muy suaves y a una 

escasa cobertura vegetal, existente solo en las zonas agrícolas. Así mismo, gracias al 

mapa que muestra los puntos donde se produjeron las inundaciones en el año 2017 a 

causa del Fenómeno del Niño Costero (Figura 87), se observó que la localización de 

estos eventos coincide con las zonas con un nivel alto de riesgo por inundaciones del 

Mapa de Inundaciones Extraordinarias. 
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• El Mapa de Inundaciones resultó del segundo modelamiento geoespacial, que de igual 

forma fue la variable pendiente la que tuvo una mayor influencia en la formación de 

inundaciones. En este modelo la zona de vulnerabilidad alta, no presentó variaciones 

significativas respecto al primer mapa, solo se presentó un incremento en su área, 

llegando a ser de 360.5 km2, esto debido principalmente a que en la parte alta de la 

cuenca aumentó la superficie por la incorporación de los datos de precipitaciones, que 

son significativas en esta zona.   

 

• El Mapa de Vulnerabilidad Física fue el tercer modelo elaborado, cuyos principales 

factores que influyeron fueron las pendientes y las precipitaciones. Así mismo, 

presentó cinco niveles de vulnerabilidad que fueron estable, bajo, moderado, alto y 

muy alto. La zona de vulnerabilidad estable se presentó en la parte más baja de la 

cuenca, en la llanura arenosa donde las pendientes son muy bajas y las precipitaciones 

escasas, con un área de 67.2 km2; la de vulnerabilidad baja contó con un área de 392.2 

km2, principalmente en la zona de los valles donde las pendientes y las precipitaciones 

son bajas; y la de nivel moderado se ubicó en la parte media de la cuenca donde las 

pendientes son escarpadas y las precipitaciones moderadas, con una superficie de 

819.2 km2. Las regiones con los niveles de vulnerabilidad alta y muy alta, presentaron 

áreas de 886.9 km2 y 79.4 km2 respectivamente, y se localizaron en la zona de los 

matorrales y montañas, donde se producen fuertes precipitaciones y las pendientes 

van de moderada a altas, en centros poblados como La Merced, Aija, Huacllan y 

Malvas. 

 

• El Mapa de la Identificación y Cuantificación de la Erosión Hídrica de la Cuenca 

Huarmey, según el método USLE, integró los factores de precipitaciones, topografía, 

cobertura y suelo. Este fue el último modelo geoespacial que se elaboró, en donde la 

cantidad de suelo perdido por erosión se clasificó en cinco niveles, las cuales fueron 

estable, bajo, moderado, alto y muy alto. La zona clasificada con un nivel estable, que 

presentó el rango de 0 a 5 t/ha.año, abarcó un área de 437.4 km2 y se localizó en la 

zona de los valles y la llanura costera, donde las pendientes son suaves y las 

precipitaciones escasas; la de nivel bajo, con un rango de 5 a 10 t/ha.año, contó con 

un área de 195.2 km2 y se ubicó en la parte media de la cuenca al lado de los valles, 

donde las pendientes son moderadas y las precipitaciones mínimas; y la de nivel 

moderado, cuyo rango fue de 10 a 50 t/ha.año, tuvo un área de 421.8 km2 y se presentó 
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en la parte media de la cuenca, donde se encuentran las colinas con pendientes 

moderadas a leves y las precipitaciones que se producen son mínimas. Las zonas con 

un nivel alto y muy alto de erosión, con un rango de 50 a 200 t/ha.año y de 200 t/ha.año 

a más, presentaron áreas de 945.3 km2 y 245.2 km2 respectivamente, y se localizaron 

en la zona de los matorrales y montañas, cuyas pendientes van de moderadas a 

escarpadas y se registran fuertes precipitaciones, en centros poblados como La 

Merced, Aija, Huacllan y Malvas.  
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VI. RECOMENDACIONES 

 

• Se recomienda considerar los resultados obtenidos en la presente investigación 

respecto a la localización de las zonas vulnerables a inundaciones y procesos de 

erosión para los planes de desarrollo en la cuenca Huarmey, por parte de las entidades 

públicas y privadas. 

 

• La Base de Datos Geoespacial es importante para la identificación de zonas 

vulnerables en la cuenca, razón por la cual se recomienda mantener actualizada la 

data, para que los modelos se optimicen y puedan ser utilizados para la elaboración 

de planes, programas, proyectos y actividades en la cuenca del río Huarmey. 

 

• En base a la experiencia, se aconseja la aplicación de tecnologías de los Sistemas de 

Información Geográfica y la Teledetección, para obtener otros modelos que muestren 

zonas susceptibles a diferentes desastres, y puedan ser utilizados en la elaboración de 

planes, programas, proyectos y actividades en las cuencas hidrográficas 

 

• La cobertura vegetal es un factor importante para reducir la erosión de una zona, es 

por ello que se recomienda como práctica de conservación, implementar la 

agroforestación en las partes altas de la cuenca, ya que con ello se podría proteger al 

suelo de la erosión gracias a las raíces profundas y la caída de las hojas, así mismo 

esto produce que se mejore la capacidad de infiltración del suelo. Cabe resaltar que 

como medidas de mantenimiento se deben prohibir las quemas en la zona, así como 

evitar el pastoreo libre en los primeros tres años.  

 

• Así mismo, se recomienda utilizar la información de la presente investigación para 

desarrollar actividades como la cosecha de aguas de lluvia y la implementación de 

surcos en contorno, zanjas de infiltración, terrazas, entre otros; en la parte alta y media 

de la cuenca para que se pueda captar este recurso hídrico en los meses de fuertes  
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precipitaciones y sea utilizado en los meses posteriores. Estas prácticas de 

conservación ayudan a que el exceso de lluvia sea utilizado para el consumo familiar 

o actividades agrícola, y de este modo no se pierda y ocasione erosión en los suelos. 

 

• Por otro lado, la limpieza de los cauces, la descolmatación de río, la implementación 

de defensas ribereñas en la parte baja de la cuenca son actividades fundamentales para 

mitigar el riesgo de inundaciones. Es importante concientizar a las autoridades sobre 

estas medidas de prevención que pueden evitar daños en la población y sus 

actividades. 
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VIII. ANEXOS 

 

• ANEXO 1  

Valores de C correspondiente al tipo de cobertura, según Montes-León et al. 2011 
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• ANEXO 2 

Valores de C correspondiente al tipo de cobertura vegetal, según Wischmeier, citado 

por Ramos Taipe 2001 

 

 

 

• ANEXO 3 

Valores de P correspondiente al tipo de prácticas de conservación, según Taipe 2001 
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• ANEXO 4 

Descarga del programa SNAP (Fuente: Tomado de STEP s.f.) 

 

 

 

• ANEXO 5 

Descarga de la herramienta Sen2Cor (Fuente: Tomado de STEP s.f.) 
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• ANEXO 6 

Archivos descargados por cada imagen satelital 

 

 

 

• ANEXO 7 

- Ubicación de la herramienta Sen2Cor 

 

 

 

- Selección de archivo 
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- Selección de la resolución de 10 m. 

 

 

 

- Archivos resultantes en el Nivel-2a 
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• ANEXO 8 

- Selección de Mosaicing 

 

 

 

- Ventana de Mosaicing 
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- Pestaña de Proyección Geográfica 
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- Pestaña de Variables y Condiciones 
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• ANEXO 9 

- Máscara de la cuenca Huarmey 

 

 

 

- Pestaña de los parámetros de entrada y salida 
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- Pestaña de parámetros del procesamiento 
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• ANEXO 10 

- ROI’s de la cuenca Huarmey 

 

 

 

- Ventana de Parámetros para la Clasificación por Máxima Probabilidad 
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• ANEXO 11 
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